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Getting Started With 
OpticStudio™ 

 
 

Congratulations on your purchase 
of Zemax OpticStudio! 

 OpticStudio is the industry standard optical system design software, combining sequential lens 

design, analysis, optimization, tolerancing, physical optics, non-sequential optical system design, 

polarization, thin-film modeling and mechanical CAD Import/Export in a single, easy-to-use 

package. 

 

Although OpticStudio is easy to use, optical system design is a very broad area of engineering. This 

guide is intended to get you started using OpticStudio quickly. It is the first place to start if you are 

new to OpticStudio, or if you are upgrading from previous versions of Zemax.  
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We strongly recommend you take the time to work all the way through this infromation on getting 

started with OpticStudio. It covers: 

 

 Installing OpticStudio, and customizing its appearance and file locations to your preference 

 Entering a simple sequential design 

 Understanding the normalized definitions OpticStudio uses 

 An overview of the multiple configurations capability 

 How to export components and rays to mechanical CAD packages 

 Optimizing a simple lens 

 Using some of the powerful tools OpticStudio makes available 

 Tilting and decentering optical components 

 Entering a simple non-sequential system, tracing rays, and using detectors 

 Colorimetry 

 Thin-Film Coatings 

 Surface, bulk and fluorescent scattering 

 

Also, our web-based Knowledge Base at www.zemax.com/kb is an indispensible resource for all 

OpticStudio users. It contains tutorials, worked examples and answers to many frequently-asked 

questions. 

 

Important notice 

 

Zemax® is a registered trademark of Zemax LLC Copyright © Zemax LLC 1990-2015. All rights 

reserved. 

 

OpticStudio™ is a trademark of Zemax LLC 2015. All rights reserved. 

 

ReverseRadiance and LightningTrace are trademarks of Zemax LLC Copyright © Zemax LLC 1990-

2015. All rights reserved. 

 

SolidWorks® is a registered trademark of Dassault Systèmes SolidWorks Corporation. 

 

AutoDesk Inventor® is a registered trademark of Autodesk, Inc. 

 

Creo Parametric® is a registered trademark of Parametric Technology Corporation. 

 

MATLAB® is a registered trademark of the The Mathworks, Inc. 
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All other product names or trademarks are property of their respective owners. 

 

Information in the help file documentation is subject to change without notice and does not 

represent a commitment on the part of the vendor. The software described in this documentation is 

furnished under a license agreement and may be used or copied only in accordance with the terms 

of the agreement. 

 

Zemax LLC provides this publication “as is” without warranty of any kind, either express or implied, 

including but not limited to the implied warranties or conditions of merchantability or fitness for a 

particular purpose. In no event shall Zemax LLC be liable for any loss of profits, loss of business, loss 

of use or data, interruption of business, or for indirect, special, incidental, or consequential damages 

of any kind, even if Zemax LLC has been advised of the possibility of such damages arising from any 

defect or error in this publication or in the Software. 

Installation 

There are two simple steps to installing OpticStudio, which must be followed in order. All files are 

downloaded from www.zemax.com/downloads. 

 

Step 1: Install the Key Driver and Plug in the Key 
 

The key driver installation is straightforward. Double-click the key driver installer once you have 

downloaded it, and choose the ‘Complete’ installation of all program features.  

A dialog box will also ask for your permission to modify the firewall settings of your computer to 

allow remote users of your computer to run ZEMAX using Remote Desktop. If you want to authorize 

this, click "Yes", otherwise click "No". To change this setting, just re-run the key driver installer. 

Plug the key in once the key driver installation is complete, and Windows will detect the hardware 

key. The green LED at the end of the key will illuminate. 

 

 

Step 2: Install Zemax OpticStudio 
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The OpticStudio installer is similarly straightforward. Download and run the installer and step 

through the on-screen instructions. You may choose where within the \program files\ hierarchy 

OpticStudio is installer (by default this is C:\Program Files\Zemax OpticStudio\). If you choose a 

different folder, any future updates you install will remember this location and treat it as the default, 

until you define a different location. 

Note that the installer will automatically scan your computer to verify the presence of Microsoft 

prerequisites that are required to run OpticStudio.  If any of the prerequisite components are 

missing, the necessary files will be downloaded and installed. These will subsequently be kept up to 

date by Windows Update. 

 

For more detailed instructions on installing OpticStudio for the first time, please our knowledge 

base article:  

http://www.zemax.com/support/knowledgebase/installing-opticstudio-for-the-first-time 

License Codes 

OpticStudio contains built-in license codes for all keys that were eligible to run this version at the 

time this version was compiled. If you have purchased a new key, this license code will not be built 

in, and OpticStudio will download the latest version of the license code file from the zemax.com 

website automatically. If for any reason it still cannot get a valid license code, the following dialog 

will appear: 

 

 

 

Use Alt-Print_Screen to copy the dialog to the clipboard and paste it into an email to 

support@zemax.com. We will promptly send you the license code or further instructions. 
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Note:  Please do not phone for a license code! License codes are complex multi-character 

strings and cannot be reliably given over the phone. Emailing the screenshot of the dialog box 

to us is the quickest and most error-free way of getting your license code. 

 

Network Keys and Clients 

 

Zemax OpticStudio can also be supplied with 5, 10, 25 and 50-user network keys. Installation is 

almost identical, except that the key driver and hardware key are installed on one computer (called 

the ‘keyserver’ machine) and Zemax OpticStudioand the Prerequisites  installed on as many other 

machines as you wish (the ‘client’ computers). When a client machine starts OpticStudio, it looks to 

the keyserver machine to see if a license is available, and if so, OpticStudio starts. 

 

Installation of the key driver on the keyserver machine is identical to the normal installation, except 

that you obviously MUST allow the firewall settings to be adjusted to allow network access to the 

key.  

 

Installation of OpticStudio on the client machines is also identical to the normal installation, except 

that you must tell OpticStudio where to look for the keyserver machine after installation. Navigate 

to whatever folder you installed OpticStudio in (by default this is C:\Program Files\Zemax 

OpticStudio\) and locate a file called sntlconfig.xml.bak. Rename this file to sntlconfig.xml, and open 

it in Notepad. Edit the following line: 

 
<ContactServer> 

10.0.0.1 

</ContactServer> 

 

Replace the default entry 10.0.0.1 with the IP address of your keyserver machine and save the file. 

 

Troubleshooting 
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OpticStudio will run without problem in the vast majority of cases. If you do experience problems, 

then visit our Knowledge Base at www.zemax.com/kb. Look at the Category ‘Installation and 

Troubleshooting’ for help. 

 

Make sure your key is plugged in! 

 

Customizing Your Installation 

 

OpticStudio installs using several default settings which you may prefer to change. You can also set 

these defaults up on a project basis, so that all designs for a specific project use the same settings. 

Start OpticStudio, and navigate to Setup…Project Preferences: 
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Navigating the OpticStudio 
Interface 

The OpticStudio user interface provides a fast, flexible platform for the design and evaluation of 

almost any optical system. 

  

 
 

It consists of several key areas: 

1. A ribbon bar which provides easy access to all the program’s features, clustered in task-

oriented tabs. Each tab contains groups of icons. In this example: 

 

 
 

Setup is the name of the ribbon bar, and System, Editors, and System Viewers are examples of 

groups. 

 

2. The System Explorer, which can be displayed or hidden at any time. This contains system-

specific information about the optical system under design. 
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3. A workspace, which is the main area in which you will do your work. 

 

 
 

 

4. A user definable Quick Access Toolbar which allows you to place your most commonly 

used features on the desktop for single-click access.  

 

 
 

The toolbar is configured under Setup…Project Preferences…Toolbars.  
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Multiple Project Preferences may be created and recalled to customize the user interface to 

the work in hand. 

 

 
 

5. A status bar, which displays useful information about the design at the bottom of the 

workspace 
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System Explorer 

 

 

The System Explorer shows the basic system settings 

that are usually input at the very start of a design 

project. Typically, these settings are not optimized, but it 

can be done if needed. 

 

The groups within the System Explorer can be 

expanded, closed, and reorganized as desired, and the 

whole System Explorer can be hidden or expanded at 

any time using the controls in the upper right corner: 

 

 
 

 
 

 

Full details are given in the System Explorer section of 

the Help Files Setup Tab chapter.  
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File Tab 

 
 

The File tab contains all the file input/output functions, split into these groups: 

 

The Lens File group contains all the normal Windows file management tasks like file opening, 

saving etc. OpticStudio files are stored in .ZMX format files, along with associated .CFG files that 

contain configuration settings and .SES files that contain settings data for all windows that were 

open at the time the file was saved. 

 

The Archive group lets you create and open OpticStudio Archive files. These are stored in .ZAR 

format, and contain all the files needed to open the file on another computer with OpticStudio 

installed on it. All OpticStudio data, glass catalogs, coatings, CAD files, SolidWorks™ etc files used 

by the lens design are compressed into this single file so that you can easily make backups of the 

design as it progresses through the design process, or transfer the design to another machine. 

 

The Export group provides access to all the export capabilities in OpticStudio, including exporting 

to STEP, IGES, SAT and STL format CAD files, and exporting to DXF and IGES linework diagrams.  

The OpticStudio Black Box feature allows you to encrypt a range of surfaces in the lens data 

spreadsheet, which can be given to other OpticStudio users without revealing the details of the 

design itself. This lets you give fully ray-traceable files to customers, or to other colleagues on a 

need-to-know basis, that give exact results on ray tyrace but do not reveal the design prescription. 

 

The Encrypted Coatings feature is a similar capability for thin-film coatings, and allows the full 

prescription of a thin-film coating to be exported in an encrypted format that allows exact ray 

tracing without making the design itself available. 

 

The Convert group lets you convert between OpticStudio’ sequential (lens design) and non-

sequential (system design) modes, and also converts various file formats (like .MAT Matlab® , .INT 

interferometer data and .f3d OptiWave data) between original and OpticStudio formats. 

See the Help Files File Tab chapter for full details of all options. 
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Setup Tab 

 
 

This tab is used when you start each design project, and is visited infrequently or not at all after 

initial setup.   

The System group puts everything to do with basic system setup in one place. Project Preferences 

lets you customize the OpticStudio installation, folder locations, quick access toolbar etc and save 

these settings to a project configuration file. 

The Editors group gives access to the spreadsheets that are used to define the optical system on a 

surface by surface or object by object basis. 

The System Viewers group gives access to the layout plots that are used to view the optical system 

itself. 

Diagnostics lets you check the OpticStudio file. The System Check utility traps many common setup 

errors. 

Windows Control defines how windows in the OpticStudio workspace behave. Windows can be 

docked, float freely, be tiled and cascaded etc. 

Configuration is used is the design has multiple versions, which is typically the case for zoom 

lenses, thermal analysis of lenses over a range of temperatures, scanning lenses and lenses with 

moving parts. The Configuration group appears on all ribbons if more than one configuration is 

defined. 

 

See the Help Files Setup Tab chapter for full details of all options. 

 

Analyze Tab 
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This tab provides access to all of OpticStudio’ analysis features in sequential UI mode. Almost all 

imaging system design is done in this UI mode. Analysis features provide detailed performance data 

over a wide range of requirements. Analysis features never change the underlying design, but 

provide diagnostic information on the design that is used to guide any required changes. 

 

The System Viewers tab gives access to the layout plots that are used to view the optical system 

itself. 

 

The Image Quality tab provides access to all the analyses used in the design of imaging and afocal 

systems, including ray-trace data, aberration data, wavefront, Point Spread Functions and more. 

 

Lasers and Fibers gives access to laser-system-specific features such as simple Gaussian Beam 

Analysis, Physical Optics and fiber coupling calculations. 

 

Polarization and Surface Physics computes the performance of thin-film coatings on individual 

surfaces, overall system performance as a function of polarization and plots of surface sag, phase 

and curvature. 

  

Reports provides text based analyses for presentation purposes. 

 

Universal Plots allow you to create your own analysis features  if required. 

 

Applications show application-specific analysis features such as Biocular system analysis, freeform 

and Progressive Addition Lens analysis, and also access to the full non-sequential features of 

OpticStudio. 

 

If the lens uses multiple configurations, the Configuration group (see Setup tab) is also shown. 

 

See the Help Files Analyze Tab chapter for full details. 
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Analyze Tab (Non-Sequential UI 
Mode) 

 
 

This tab provides access to all of OpticStudio’ analysis features in non-sequential UI mode, which is 

used for most illumination, stray light, lighting, etc. designs. Analysis features provide detailed 

performance data over a wide range of requirements. Analysis features never change the underlying 

design, but provide diagnostic information on the design that is used to guide any required 

changes. 

 

The System Viewers group gives access to the layout plots that are used to view the optical system 

itself. 

Trace Rays initiates ray tracing using either the comprehensive non-sequential ray-trace engine, or 

a faster, approximate method called LightningTrace™ that is very useful if the source can be 

approximated as a point source. 

Detectors and Raytrace Analysis groups provide a wide range of analyses on a previously 

performed raytrace. 

Polarization computes the performance of thin-film coatings on individual faces of objects. 

Universal Plots allow you to create your own analysis features  if required. 

Applications show application-specific analysis features such as Roadway Lighting Analysis 

 

See the Help Files Analyze Tab chapter for full details. 
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Optimize Tab 

 
 

This tab is where you control the Zemax optimization capabilities. 

 

Manual Adjustment contains a series of features that let you manually adjust the design for 

desired performance. This group is only available in Sequential UI mode. 

 

Automatic Optimization provides access to the Merit Function Editor, which is how a system’s 

performance specification is defined in Zemax. The Optimization Wizard lets you quickly generate a 

merit function based on the most common requirements (smallest spot, best wavefront error, least 

angular deviation) which can then be edited to your exact requirements. 

 

Global Optimization is used in two main scenarios: at the start of a design process (Global) in order 

to generate design forms for further analysis, and after initial optimization (Hammer) to exhaustively 

improve the current design. 

 

Optimization Tools performs a range of post-optimization functions such as finding the best 

surface to aspherize or swapping lenses in the current design for catalog optics. This group is only 

available in Sequential UI mode 

 

See the Help Files Optimize Tab chapter for full details.   



 

Zemax, LLC Getting Started With OpticStudio 15 Navigating the OpticStudio Interface    22 

Tolerance Tab 

 
 

Tolerancing allows you to see the effect of finite manufacturing and assembly tolerances on the 

design. 

 

In the Tolerancing group, the Tolerance Data Editor is where you will enter the tolerances you wish 

to place on each parameter. The Tolerance Wizard will quickly set up a set of tolerances which you 

can then edit. 

 

The Manufacturing Drawings and Data group (Sequential UI mode only) creates manufacturing 

drawings in ISO 10110 format and a Zemax-specific format, as well as exporting data about the 

surface to cross-check manufacturing setup. 

 

The Freeform Manufacturing Data group provides surface information that can be used in 

manufacturing a tolerancing. 

 

The Cost Estimator is a tool that estimates the cost to manufacture a lens.   

 

See the Help Files Tolerance Tab chapter for full details. 

 

Libraries Tab 

 
 

OpticStudio ships with a lot of data on optical materials, stock lenses, thin-film coatings and light 

sources built in, in the form of catalog data, plus you can add your own data as well. This tab 

provides access to all the catalog data that ships with OpticStudio and also lets you enter your own 

data. 
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The Optical Materials group gives access to catalogs of glasses, plastics, birefringent media and 

more. 

 

The Stock Parts group holds all the vendor lens catalogs in Zemax, which can be quickly searched 

to find the correct lenses for your application. 

 

The Coatings group contains data and tools for designing thin-film coatings and applying them to 

optical surfaces. 

 

The Scattering group gives access to Zemax’s surface scattering libraries and scatter viewers. The IS 

Scatter Catalog contains measured data for a range of optical finishes including various matt blacks, 

ground glass and anisotropic scattering surfaces. 

 

The Sources group gives access to the libraries of Radiant Source (spatial, angular and optionally 

wavelength) data and IES (angular only) data. Spectral (color) information can be added to data files 

that do not have it, and there are several source viewer options. 

 

The Source Viewers group includes tools for modeling source directivity plots and spectra.  

 

See Help Files The Libraries Tab chapter for full details. 

 

Part Designer Tab 

 
 

The Part Designer is a sophisticated geometry creation tool capable of making parametric objects 

which are optimizable within OpticStudio Premium. Part Designer is only available in the Non-

Sequential UI mode. 

 

See the Help Files Part Designer Tab chapter for full details.   
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Programming Tab 

 
 

Although OpticStudio has a huge range of features and analysis options, there is always some 

special feature or requirement. That’s why OpticStudio has programming interfaces built right in. 

The first is Zemax Programming Language (ZPL), which is a very easy to learn scripting language 

similar to Basic. With ZPL, it is easy to perform special calculations, display data in different ways 

and automate repetitive keyboard tasks, amongst many others. 

 

‘Extensions’ are external programs that can take control of Zemax, instruct it to perform analyses 

and extract data from it. MatLab® and Python are two of the most common programs to work with 

OpticStudio, plus you can write your own program which can use zclient, our Software Development 

Kit (SDK) for applications programmers. 

 

Zemax OpticStudio also has a ZOS-API programming interface which can be used in a .NET 

environment, using C#, or any other .NET-capable language.  In addition, ZOSAPI can also be used 

in a .COM environment, using C++, or any other .COM-capable language.   

 

See the Help Files Programming Tab chapter for full details.  
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Help Tab 

 
 

The Help tab provides links to this Help file, plus links to our web-based Knowledge Base, website, 

and user forums. 

 

See the Help Files Help Tab chapter for full details.   

 

Using Spreadsheet Editors 

Most data about your optical system is contained in one or more spreadsheets. OpticStudio’s 

spreadsheets are designed to behave like Microsoft Excel® sheets as much as possible, to make 

them familiar. There are some specific optical system design touches to make you very productive 

when using OpticStudio. Here is a typical Editor: 
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All Editors contain three areas: 

1. A Toolbar area at the top which provides tools for manipulating the data in the editor and 

performing tasks specific to that data. For example, the first icon in the Lens Data Editor 

above is a Tilt/Decenter elements tool which allows any group of elements to be tilted and 

decentered. 

2. A collapsible Properties dialog that lets you see and set detailed data about each row or 

item in the editor. This is typically reserved for data that is set once and then not changed 

frequently. The Properties can be hidden (collapsed) when not needed. 

3. The Spreadsheet region which is where the data you need to work with is kept. Spreadsheet 

cell data can be entered directly, or can be calculated by Solves, which act similarly to 

spreadsheet functions in Excel®  

 

Each Editor, its toolbar and Properties is discussed in detail in its own chapter. 

 

For more information see the “Using the Editors” section  in the Help Files under The Setup Tab > 

Editors Group.  
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Using Analysis Windows 

 
 

All Analysis windows contain four main areas: 

1. A toolbar, which is common across all Analysis windows. This gives access to the Analysis 

Settings, which control the calculation, and various controls like print, copy, save as etc 

2. The Settings dialog, which can be shown or hidden by using the Setting control on the 

toolbar. 

3. The data analysis itself, which can be shown in three ways: as a graphic, as a text listing and 

(some windows only) in ‘Classic’ mode which uses the graphics libraries from older versions 

of Zemax. 
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4. A context menu that appears when the right-mouse button is clicked: 

 
 

 

For more information see the Help Files Analyze Tab chapter.   
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Using the Shaded Model 

 
 

The Shaded Model lets you view your system through an advanced graphics view familiar to anyone 

who has used modern CAD programs. Mouse control of the view is intuitive, and the toolbar gives 

access to default views (Isometric, X-Y, Y-Z and Z-Y) and cutting planes which can be used 

interactively to show the level of detail you need. There are options for wireframe, hidden line or 

solid modeling views. 

 

See the Shaded Model section of the Help Files Analyze Tab chapter for full details.   

 

Arranging Windows 

 Windows can be free-floating or docked, and docked windows can be tiled in any way you wish. 

This is best described in a video: 

 

Watch the video: Arranging Windows : 
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http://zemax.com/products/opticstudio/feature-explorer/user-interface/window-management 

 

 

 

Printing Windows 

 

The Graphics section of the Help Files > Setup Tab > Project Preferences includes settings for 

printing layout plots to scale and the default printing orientation.   

 

In addition, the printer icon in the toolbar of any analysis window will bring up a Print Preview 

dialog window.  This dialog allows you to configure options such as the desired printer, scaling, and 

page ranges.  The print shortcut key will also open the Print Preview window, and by default this 

shortcut is “Ctrl + P”.   

 

 
 

Advanced Settings 

 

Use the link with the selected printer name at the top-left corner, or the Properties button to choose 

the desired printer as well as advanced printer driver settings.  Note that the 'Print' button on the 
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advanced settings dialog does not actually print, but merely accepts the new settings and closes the 

dialog. 

 

 

Orientation 

 

The orientation controls whether the output is printed in Portrait or Landscape mode.  There are 

four options: 

1. Default – use the current value from the printer advanced settings. 

2. Automatic – determine the best fit based on the paper dimensions and selected scaling 

mode. 

3. Portrait 

4. Landscape 

Immediately below the orientation selection box, the computed orientation will be displayed (useful 

when selecting Default or Automatic). 

 

 

Scaling 

 

Scaling determines how the graphic is scaled to fit the output pages.  Note that all scaling options 

are applied equally to both axes (i.e. aspect ratio is maintained).  There are currently three options: 

1. Fit To Page – take up the most space possible on a single page. 

2. Original Size – attempt to print at exactly the size the input text or graphic is currently 

displayed on the screen (not the size in the preview window). 

3. Print To Scale (only for layout plots) - the layout plot will be printed at a 1:1 scale based 

on the lens units. 

 

The Center option is used to pad the graphic so that it is centered on the print page(s), rather than 

on the upper-left hand corner. 

 

 

Selection 
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There are several options to select which of the available pages are printed.  Use the preview page 

controls at the bottom right to decide which pages you want printed, and then choose from the 

following options: 

1. All 

2. Range – used to select a contiguous range of pages to print, from x to y. 

3. Current – only print the current preview page. 

4. Selected (only for text) – only print the currently selected analysis text.  Note that this 

option is only available when printing text, and only when a block was selected before 

opening the print dialog. 

Tutorials 

In this section we give several examples of how to use OpticStudio. We strongly recommend that 

you take the time to work through this section. 

 

If you are viewing this in an HTML dialog, expand the “Tutorials” topic in the Contents tab to view 

the subsections.   

 

 

Tutorial 1: A Walk-Through an 
OpticStudio Design 

In this example we open one of the sample files provided with OpticStudio and get familiar with the 

use of the various controls. Open OpticStudio (click File…New if it is already open) and in the Setup 

tab choose ‘Dock New Windows’ 
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Then click on File…Open and select the file {Current 

User}\Documents\Zemax\Samples\Sequential\Objectives\Double Gauss 28 degree field.zmx.   This is 

a classic lens design, and even if you intend to use only the non-sequential mode of OpticStudio 

you should still follow this example. The user interface is common to both sequential and non-

sequential ray-tracing, and users of all versions of OpticStudio will be able to work through this 

example. The OpticStudio window will look like so: 
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Click on the Layout tab, and right-mouse click on the tab to show the window placement menu: 

 

Experiment with floating and docking windows. Then click on the Layout tab with the left-mouse-

button and drag the window away from the dock until the Window Manager icon appears. Use this 

to place the layout below the other three windows: 

 

And release the mouse button: 
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Repeat this process to get the following workspace layout: 
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Then make this arrangement: 



 

Zemax, LLC Getting Started With OpticStudio 15 Tutorials    37 

 

This shows one of the key features of the OpticStudio interface. Any open window many be floating 

(placed where you put it, and independent of any other window), or arranged in the workspace, or 

placed in a tab group with any other window etc. 

Next, within the Setup tab, click on Performance in the Diagnostics group: 
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This will give you a simple metric of how fast OpticStudio is on your computer. It also shows one of 

the best features of OpticStudio: its ability to use multiple CPUs in your computer, if available, to 

trace millions of rays per second. Calculations are split up and spread over all available CPUs, and 

the results stitched back together again, without any user interaction. 
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Tutorial 1.1: The Lens Data Editor 

 

In sequential ray-tracing, light is traced from its source, called the ‘Object’ surface, to surface 1, then 

to surface 2, 3, etc. until it lands on the final ‘Image’ surface. For historical reasons this surface is 

always called the Image surface, even though the optical system may not form an image of the 

source. A laser beam expander or eyepiece for example may be afocal: this is covered later. 

Surfaces are inserted or deleted in the editor using the Insert or Delete keyboard keys, or via the 

right-mouse click Context menu 
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which also allows individual cells or the entire spreadsheet to be copied to the clipboard. Column 

widths can be varied by placing the cursor in the top row, over the column separator. When the 

cursor turns to a ↔ symbol, click and hold the left mouse button to resize the column. Columns can 

be moved by clicking on the column header, holding the mouse down and dragging. 

The ‘V’ next to some parameters means that this parameter is ‘variable’. OpticStudio is allowed to 

change the values in such cells in order to improve the performance. This will be discussed in more 

detail later. 

 

Surfaces also have a set of properties that are not directly visible in the editor until the Property 

Inspector is opened. These are generally those properties that are set and then not changed. To see 

these properties, move the mouse over the Type cell of the chosen surface, and double click.  

 

 
Alternatively, click on the Property Inspector as shown above. A multi-tab dialog appears. From the 

Surface Type drop-down list you can select the type of the surface, which can be aspheric, 

diffraction grating, toroidal, etc. 

 

Spend some time exploring each tab. The most commonly used tabs are the Type, Draw, Aperture 

and the Tilt/Decenter tabs. Press the Help button on each tab to read the on-line Help. 
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Tutorial 1.2: Analysis Windows 

Analysis windows provide either graphical or text-based data computed from the lens as entered in 

the Editor. Analysis windows never change the lens data: they provide diagnostic information of the 

various aspects of the lens system’s performance. 

 

Analysis windows all operate with the same user interface and have the same menu bar: 

 Pressing the Settings icon will toggle a dialog box that controls the input parameters passed 

to the calculation.  The Save, Load and Reset buttons allow default settings to be saved, 

recalled or reset to ‘factory’ defaults. If you save the settings of any window, those become 

the defaults for every file that does not have its own settings, so your preferences 

automatically flow through all your work.  
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 Pressing the Update menu item (next to the Settings icon), or double-clicking anywhere in 

the Analysis window with the left mouse button, will make the Analysis window recompute 

 

 There are standard Copy, Save As and Print icons 

 Right-mouse-clicking will make a context menu show. Analysis windows showing three 

dimensional data have more options than 2D data plots 

 A set of annotation tools let you mark up the analysis feature with text, boxes, arrows, lines 

etc.: 

 

 Windows can be locked, unlocked, cloned, overlaid and have their drawing resolution 

changed 

 

 You can zoom in on a section of interest by clicking the left mouse button, holding it down 

and dragging it over the region you wish to zoom in on, or by clicking and dragging the 

grey bars at the ends of the x and y axis, or by choosing ‘Edit Axis Options’ from the right-

mouse menu. A text tab shows the data on which the calculation is based. This can be 

copied to the clipboard in whole or in part (by highlighting the section desired and right 

mouse clicking) or saved to a text file. 
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Spend some time playing with the features of the Analysis windows. Remember Analysis windows 

never change the data in the design, so you cannot do any damage! 

Tutorial 1.3: The System Explorer 
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The System Explorer defines the 

light entering the system as well as 

many other basic system 

parameters. Data entered in the 

System Explorer is usually set once 

and not altered, or altered only 

occasionally as the design matures, 

although full optimization of System 

Explorer data is supported if needed. 

For example, the Aperture of this 

lens is set to be ‘Entrance Pupil 

Diameter’, so the EPD is specified 

directly, and is set to be 33.33 ‘Lens 

Units’. All items having units of 

length are given in Lens Units except 

where specifically noted. Click on 

the Units tab to see what the Lens 

Units of this lens are (they can be 

mm, cm, meters or inches). 

 

Entrance Pupil Diameter (EPD) 

defines the size of the on-axis 

bundle of light entering the lens 

system. In the double-Gauss sample 

file we are using, which is a 

traditional SLR-type camera lens, 

OpticStudio traces rays at this 

height through the lens and 

computes the size of the aperture 

stop surface (marked as STOP in the 

Lens Data Editor), drawn in red 

opposite. The aperture stop surface 

is usually a ring diaphragm, so in 

reality the radial size of this surface 

defines the EPD, not the other way 

around. 

 

If you prefer this alternative 

definition, then choose the Aperture 

Type in the General dialog box to be 

‘Float by Stop’, and then change the 

semi-diameter of the STOP surface 

to say 8 mm. Double-click all the 

open Analysis windows to make 
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The Fields Section 

 

them update to reflect this change, 

and notice the change in the lens 

apertures and performance. 

OpticStudio automatically computes 

the appropriate size of each surface 

so that all light passes through each 

surface. 

 

Another commonly used Aperture 

Type is ‘Object Space NA’ which is 

appropriate when the source is 

something like an optical fiber that 

radiates out in a defined numerical 

aperture. Use ‘Object Cone Angle’ if 

the source is defined by a source 

angle in degrees instead of NA. 

  

The term “Field” is short for field-of-view and it can be defined in three ways, one of which supports 

two options: 

 The height of the object scene being imaged 

 The height of the image being formed, which may be chosen to be either a real or paraxial 

image height 

 The angle subtended by the object scene at the lens 
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Field data can be entered by expanding the Fields section of the System Explorer, or by double-

clicking the Fields data section to show a dialog box: 
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In the double Gauss sample file, we cannot use Object Height as a definition because the object 

surface is at infinity. Instead, the field angle subtended at the pupil is used, and this is commonly 

done in camera design. Alternatively, we might use image height when the detector is a fixed size 

like a CCD chip, and in this case the field of view is defined by what the detector can ‘see’ when 

looking out through the lens. 

The Wavelengths Section 

 

 
Wavelengths are always entered in microns. Wavelength weights can be used to define relative 

spectral intensity, or simply to define which wavelengths are most important in a design. The 

‘primary’ wavelength is used as a default wavelength: for example, if asked to compute effective 

focal length, OpticStudio will compute it at the primary wavelength if no wavelength is specified. 

 

Wavelength data is entered in the System Explorer by expending the Wavelengths data section, or 

by double-clicking it to give a dialog box. 

Tutorial 1.4: The Normalized Coordinate 
System 

Because there are six ways to define system aperture, and four ways to define field of view, it is 

convenient to work in normalized coordinates. When performing the initial setup of your system 

you should choose the most appropriate aperture definition, and the most appropriate field 
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definition, and enter the data for both of these. Subsequently, all calculations use normalized units, 

and you do not have to refer to the specific values entered or definitions used. 

Normalized Field Coordinates 

Normalized field coordinates Hx and Hy are used throughout OpticStudio, its documentation, and 

in the wider optical design literature. The normalized field coordinate (0, 1) for example, is always at 

the top of the field of view in y, whether the field points are defined as angles or heights, and 

regardless of the magnitude of the field coordinates. Similarly the field coordinate (0,0) is always at 

the center of the field of view. 

For example, suppose 3 field points are defined in the (x, y) directions using object height in lens 

units of millimeters at (0, 0), (10, 0), and (0, 3). The field point with the maximum radial coordinate is 

the second field point, and the maximum radial field is therefore 10 mm. The normalized coordinate 

(Hx =0, Hy = 1) refers to the location on the object surface (as the field of view is defined in object 

height) of x= 0, y =10 mm. The normalized coordinate (Hx = 1, Hy = 0) refers to the object surface 

location (10, 0).  

You can then define any point within the field of view of the lens by its (Hx, Hy) coordinates, as long 

as Hx
2 + Hy

2 ≤ 1. 

This is referred to as radial field normalization, as the normalized field coordinates represent points 

on a unit circle. OpticStudio also supports rectangular field normalization, in which the normalized 

field coordinates represent points on a unit rectangle. 
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Normalized Pupil Coordinates 

Similarly, normalized pupil coordinates are also used throughout OpticStudio, its documentation, 

and in the wider optical design literature. You define the system aperture using whatever definition 

is most useful, and thereafter we use the normalized pupil coordinates Px and Py to define any point 

within a unit circle. Therefore, the point (0,1) represents a point at the top of the bundle of rays 

entering the system, and (0, 0) is a point at the center of the ray bundle, no matter what the 

definition of system aperture is or what value it has. 

 

Using the Normalized Coordinates 

Re-open the double Gauss 28 degree field sample file in order to undo any changes you may have 

made in the earlier sections. Open the Field section of the System Explorer and note that the field is 

defined as angle in degrees, and the maximum field point has a value of 14°. This is a half-angle, 

and so the full field of view is 28°.   

Note: OpticStudio is always clear on the definitions it uses, but these definitions are not universal in 

the optics industry. Always clarify with your customers what definitions they use for important system 

specifications to avoid costly errors! 

Then expand the Aperture section of the System Explorer and note that the system aperture is 

defined as Entrance Pupil Diameter, value 33.33. Go to the Units tab to see that the lens units are 

millimeters, so the EPD is 33.33 mm. 

Lastly, expand the Wavelength section and note that the design uses three wavelengths, at 0.4861, 

0.5876 and 0.6563 microns respectively. The primary wavelength is set as wavelength number 2, 

which is 0.5876 microns. 

Now click on the Analysis tab, and select Rays and Spots…Ray Trace. This is the most fundamental 

calculation in OpticStudio: the tracing of a single ray. Right-mouse click on this window to bring up 

its Settings dialog box: 
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Note how you can define any ray by where it starts on the object surface in normalized (Hx, Hy) 

coordinates, and where it goes to in the pupil in normalized (Px, Py) coordinates. Try tracing some 

rays, and look at the data provided by this feature. You are given the (x,y,z) position of the ray, the 

direction cosines of the ray, and the path length of the ray at each surface of the system. This is the 

fundamental data on which all the calculations in sequential ray tracing are based. 

Note also that instead of defining ‘arbitrary’ field coordinates (Hx, Hy) you can also define the 

starting coordinates of the ray by the field point number: 
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Since field point 3 defines the maximum radial field, it is at (0, 1) in normalized field coordinates. 

Field point 2 is likewise at (0, .714) and field point 1 is at (0, 0). Depending on the Analysis feature 

selected, field points can be defined by either their field point number (as entered in the Field dialog 

box) or by their (Hx, Hy) values. 
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Tutorial 2: Defining, Positioning and 
Moving Surfaces 

Click on File…Open and select the file {Current 

User}\Documents\Zemax\Samples\Sequential\Objectives\Double Gauss 28 degree field.zmx.  If you 

already have this file open from Tutorial 1, re-open it to lose any changes you may have made during 

that tutorial. 

In ‘sequential’ lens design, light always starts at surface 0, the ‘object’ surface, and is traced to 

surface 1, then surface 2, then 3 etc. It therefore makes sense to position surfaces relative to each 

other. Returning to the double Gauss sample file, look at the Lens Data Editor, and click on surface 

3. Note that this surface is drawn in red in the Layout plots when you click on it in the editor.  

Rays propagate from left to right in the layout, and this direction is the +Z axis. The +Y axis goes 

from the bottom to the top of the window, and the +X axis goes ‘into’ the screen. If you position 

your right hand, such that your middle finger is touching surface 1 in the layout window and points 

into the screen, your index finger is pointing towards the right hand of the screen, and your thumb 

is pointing upwards, you have the classic ‘right hand coordinate system’ used throughout 

OpticStudio and in most of the optical design literature. The Coordinate Axes are always drawn in 

the Shaded Model plot, below 

Also, observe that as you move your mouse over the layout window, the coordinates of the mouse 

pointer are shown in the title bar of the window: 
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If you move the mouse across the Layout window, you will see the Z coordinate change, and as you 

move the mouse up or down the window, the Y value will change.  

The Lens Data Editor shows the following data for surface 1 (if you are using the Demonstration 

version of OpticStudio, fewer decimal places are shown: 

Radius of curvature: 54.153 

Thickness:   8.747 

Material:   SK2 

Semi-diameter:  29.225 

Conic:   0 

Remember that any lengths where the units are not explicitly given are in “Lens Units”, which are in 

mm for this file (see System Explorer ‘Units’ section).  

The radius of curvature of surface 1 is 54.153 mm. This is a positive number because the center of 

curvature lies in positive Z. By contrast, surface 7 has a radius of curvature of -25.685 mm because 

its center of curvature lies in –Z. 

Surface 1’s thickness of 8.747 mm means that surface 2 is located 8.747 in positive Z relative to 

surface 1. “Thickness” is therefore the distance along Z of two surfaces. We refer to this as 

‘thickness’ in the editor rather than ‘z-distance’ because if you were to hold the lens formed by 

surfaces 1 and 2 in your hand, you would naturally describe the lens as having a center thickness. 
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Surface 1’s Material type is set to SK2, which means that the space between surface 1 and surface 2 

is filled by a particular glass called SK2. Click on the SK2 glass in the editor, and then click on the 

Libraries tab and then the Materials Catalog icon: 

 

This shows that SK2 is a material in the Schott catalog, and it gives all the data OpticStudio knows 

about the glass. 

Note:  A full discussion of this dialog is outside of the scope of this Tutorial. See the “Using Glass 

Catalogs” section of the Technical Reference for full details. 

Next, see that surface 2 has no entry for its Glass column, and is instead blank. That means that 

surface 2 is made of ‘Air’ at Standard Temperature and Pressure. Both temperature and pressure can 

be changed, both at a system level and on a surface-by-surface basis. This has important, but subtle, 

effects. First, the index of refraction of glass depends upon both temperature and wavelength; 

relative indices which are measured with respect to air also change with pressure. Second, glass 

expands and contracts with temperature, which can change the radius, thickness, or other 

dimensions of a lens. Third, the distances between lenses change due to the expansion and 

contraction of the mounting material. 

The thermal analysis features of OpticStudio can account for all these effects. OpticStudio can be 

used to analyze and optimize a design for any specific temperature or for a range of temperatures. 
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This is outside of the scope of this Guide, however, and we will assume that the whole lens is at 20° 

C, 1 Atm pressure. 

Note: See the “Thermal Analysis” section of the Technical Reference for full details of the 

comprehensive temperature and pressure modelling capabilities of OpticStudio.  

The “Semi-Diameter” column shows the radial height of the surface (it is called Semi-Diameter to 

avoid confusion with radius of curvature). This can be computed in two ways: automatically by 

OpticStudio (the default), or directly entered by the user. 

The automatic calculation sets the semi-diameter to ensure that the edge rays always pass through 

the lens. This means that the lenses are ‘just big enough’ to pass the full aperture of rays from 

across the field of view. Usually, lenses are made a little larger than this, so there is some unused 

glass that can be used to hold the lens in its mount without blocking the beam. You can specify the 

additional amount easily by adding a semi-diameter margin in System Explorer’s Miscellaneous 

group. 
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Tutorial 2.1: Working in Three 
Dimensions 

The double Gauss example lens is an axially symmetric lens, and so each surface is simply positioned 

a distance in Z away from the previous surface. But what about systems in which optical 

components are tilted or decentered with respect to each other? 

Let’s imagine that the second group of elements (the doublet and singlet after the stop) is tilted and 

decentered with respect to the first. Click on surface 7 in the Lens Data Editor, then hold the left-

mouse button down while dragging with the mouse to highlight surfaces 7 to 11. Alternatively, click 

on surface 7, and press the Shift key while also pressing the down cursor key to highlight surfaces 7-

11.  

 

In the Lens Data Editor’s Toolbar, click the Tilt/Decenter Elements icon and configure it as shown: 
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After you press OK, click on System…Update All to update all the open windows. Note that the 

Layout plot displays a warning ‘Cannot perform 2D layout on non-axial system’. Close this window, 

and click on the Analyze Tab, System Viewers group and choose the Shaded Model. Configure it like 
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so: 

 

You can see that the second group of elements has been shifted in the y-direction (upwards in the 

Shaded Model) and rotated around x (the x-axis points into the screen). Click anywhere inside the 

3D Layout window so that this window is active (the title bar will appear brighter than the other 

OpticStudio Analysis windows). The layout can be rotated by using the mouse or by the Rotation 

X/Y/Z controls in the Settings dialog box for this window. 

Return to the Lens Data Editor, and see that OpticStudio has now entered two new surfaces into the 

design and that the editor now has additional columns.  



 

Zemax, LLC Getting Started With OpticStudio 15 Tutorials    59 

 

These are called Coordinate Break (CB) surfaces. Coordinate Break surfaces have no optical effect; 

they just define a new coordinate system relative to the previous surface’s coordinate system. Click 

on the first CB surface, and scroll to the right in the Editor. See that the surface has a decentration in 

x, then y, and a tilt in x, y, and z. If you filled in the dialog as shown above, you should see a 

decentration in y of 2 mm, a tilt about x of 5 degrees, and have an order flag of 0. This means that 

the CB will execute ‘left to right’, meaning that the decentration in x is done first, then the 

decentration in y, then the tilt in x, etc.    

Now look at the second CB. It has a decentration in y of -2 mm and a tilt in x of -5 degrees. This 

‘undoes’ the tilt/decentration of the first CB. Also its order flag is not zero, so it executes ‘right to 

left’. This means that the second CB undoes the first CB, and restores the coordinate system to its 

original frame of reference. 

Note also the letter P next to the decenters and tilts of the second CB. This indicates that a ‘Pick-Up 

Solve’ has been placed on this parameter. Click on the P symbol of the Tilt-X parameter of the 

second CB, and the pickup dialog will open: 

 

  



 

Zemax, LLC Getting Started With OpticStudio 15 Tutorials    60 

This locks the value of parameter 3 on surface 13 to be whatever the value of parameter 2, surface 7 

is, except the sign is the opposite. The pick-up solve is one of the Editor’s most useful features, as it 

allows one part of an optical system to be locked to another. 

Note: If you visit the OpticStudio User’s Knowledge Base at www.zemax.com/kb, look at the category 

Sequential Ray Tracing/3D Geometries for many helpful articles about the use of Coordinate Break 

surfaces. 

 

Tutorial 3: A Multi-Configuration 
Design 

 

OpticStudio can also work with multiple configurations, or versions, of a design. This is typically 

used to model zoom lenses (where the spacings between lenses changes), systems where the 

temperature changes, and systems where the angle of a scanning mirror changes, amongst many 

others. We will use this now to model a system in which the spot produced by a catalog lens is 

scanned by a mirror over the image surface. 

 

OpticStudio includes the lens catalogs of all the major vendors so you can easily find catalog lenses. 

Click File…New to clear OpticStudio, and click on Libraries…Lens Catalog: 

 

 
and configure the dialog box like so: 
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This searches for plano-convex singlet lenses with focal lengths between 99 and 101 mm, and 

Entrance Pupil Diameters between 20 and 25 mm. Note that there are 27 lenses that meet these 

criteria out of the 4060 files included in the Edmund Optics catalog. Select the lens 32481, and press 

the Load button. OpticStudio then loads this stock lens: 
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This uses the Shaded model in the YZ orientation, with a Y|Z slicing plane used to give a cross-

section view as well as the solid model view. 

  

Our goal is to design a scanning mirror that scans the focal spot through ±10° around a nominal 90° 

reflection angle.  

 

First, note that the lens has been entered so that it is illuminated right up to the edge of its 

mechanical aperture. Since the lens will be held in a mount of some sort, we need to reduce the 

Entrance Pupil Diameter a little (since this is a catalog lens, the mechanical diameter is fixed). Open 

the System Explorer, and set the Aperture to be 18. Check the Units tab to see what the Lens Units 

are. 

 

Next, click anywhere on surface 2 in the Lens Data Editor, to highlight surface2. Note that the 

thickness of this surface is controlled by a marginal ray height solve, and can be seen by the M 

following the thickness. This keeps the lens at paraxial focus. We will discuss solves more later. For 

now, simply press Insert after clicking on surface 2, to insert a new surface. Give this surface a 
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thickness of 70 mm, and note that the thickness of the last surface automatically changes to keep 

this lens in focus: 

 
  

 
  

We will now make surface 3 a ‘Fold Mirror’ which just reflects the light through some angle. Click on 

surface 3, and then click on the Add Fold Mirror icon in the Lens Data Editor toolbar: 
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and configure it like so: 
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The Shaded Model will now show: 

 

 
  

The Add Fold Mirror tool inserts two dummy surfaces, one before and one after the selected fold 

surface. The fold surface then has its material type set to MIRROR, which is a special status that tells 

OpticStudio that light should now reflect from this surface rather than refract into it. The two newly 

inserted adjacent surfaces are set to be Coordinate Breaks with the appropriate tilt angles. The 

second tilt angle is set as a pickup from the first tilt angle. Finally, all subsequent surface thicknesses 

and curvatures change sign to account for the new mirror.  
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Remember that light normally propagates in +Z (left to right) but after a mirror it obviously goes in 

the other direction. Using the Add Fold Mirror/Delete Fold Mirror tools automates all the tedious 

sign conversions. 

 

We now want to scan this mirror through ±10°. We will initially tilt it through +10°, and then use 

multiple configurations to define multiple tilt angles. Click on surface 4 (which is the mirror surface 

now) and press the Tilt/Decenter icon in the Toolbar: 

 

  
And configure as follows: 
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The Tilt/Decenter Element tool has operated just as it did in the earlier double-Gauss example, and 

it has added two more Coordinate Break surfaces, with pickups, that tilt the mirror surface. The two 

sets of Coordinate Breaks are ‘nested’, such that the set added by the Tilt/Decenter tool are inside 

the pair added by the Fold Mirror tool: 

 

 
  

You can vary the +10° value by hand, and watch the Shaded Model, or click on the Optimize tab 

and select the Slider  icon 
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and configure it like so: 

  

 
 

Press the ‘Animate’ button and all open windows will update as the Tilt About X (parameter 3) of 

surface 4 is scanned.  You can also just drag the slider with the mouse. Now exit the slider, and reset 

the tilt in surface 4 to +10 degrees if needed. 

 

Next, go to the Setup Tab, and press the Multiple Configuration icon in the Configurations group: 
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The lens currently has only one configuration, and the multiple-configuration operand MOFF 

(“Multiconfiguration OFF”) is a placeholder that affects nothing, and allows you to enter comments 

in the editor if desired.   

 

Note: The Multi-Configuration Editor is used to define everything that is different between 

configurations. 

 

We will define 5 configurations, representing scan angles of +10°, +5°, 0°, -5° and -10° respectively. 

Click on the Multi-Configuration Editor, and press the Insert Configuration icon (highlighted above) 

four times. Alternatively, you can either right-mouse-click…Insert Configuration four times, or press 

the <Shift><Ctrl><Insert> keys simultaneously four times, that a total of five configurations results: 

 

 
  

Each line in the Multi-Configuration Editor is an operand that acts on a parameter in the Lens Data 

Editor or some other System parameter and allows its value to be changed. Move the mouse over 

the ‘MOFF’ operand and double-left-click to edit the operand. All the multiple configuration 

operands OpticStudio supports can be selected from the drop-down list in the resulting dialog. Set 

it up like so: 
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So that the PRAM operand picks up parameter data, in this case parameter 3 of surface 4, and 

changes it between 10, 5, 0, -5 and 10 degrees. 

 

Use the <cntl>A keys to change the current configuration, and note that all open windows update 

to show the data for whatever configuration is current. Alternatively, use these controls: 

 
(Note that the Configuration group now appears on all tabs except the File tab as soon as the Multi-

configuration Editor contains more than one configuration). You can also double-click on the 

header of each configuration’s column to make it the active configuration. 

  

 Configure the Shaded Model like so: 
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Note you can select any number of individual configurations to draw, like 1/5 and 4/5 by just 

selecting the desired configurations in the drop-down list. 

 

Finally, click on the Analyze Tab…Spot Diagrams…Configuration Matrix  

 



 

Zemax, LLC Getting Started With OpticStudio 15 Tutorials    72 

 
to see how the spot varies with scan angle: 
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Finally, on the Lens Data Editor Toolbar, choose Apertures…Convert Semi-Diameters to Maximum 

Apertures 

 

 
This will set the semi-diameters of all surfaces to the largest of whichever configuration needs it: 
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Tutorial 4: Exporting To Mechanical 
CAD Packages 

 

At some point in your lens design, you may want to export the lens design into a mechanical design 

package so that you or your mechanical engineering colleagues can design lens mounts and other 

opto-mechanical components alongside the lenses and rays. This is easily achieved using the Export 

group in the File tab: 

 

 
  

Using the file designed in Turorial 3, export it like so: 
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And load the file produced into your 3D CAD package of choice: 
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Note: If you are using SolidWorks™, and do not see the exported rays, visit the OpticStudio User’s 

Knowledge Base at www.zemax.com/kb and search for “SolidWorks” to get advice on how to set 

SolidWorks’ importer options. 

 

This lets you see easily the range of motion of the mirror, the envelope of the rays, and the optical 

components. Multiple configurations can be exported as separate files, as separate layers of the 

same file, or ‘all at once’ as done here. 

Importing CAD objects is discussed in the non-sequential ray-tracing section of this Guide. 
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Tutorial 5: Optimization 

 

So far, we have loaded a lens file, and used Analysis features to look at the performance of the 

system. Optimization takes this to the next level: OpticStudio will actively work with you to obtain 

the best possible system performance, and not simply report what the system performance is. 

 

Note: Even if you intend to use only the non-sequential mode of OpticStudio you should work through 

this example, as the concepts of optimization are the same in non-sequential ray-tracing as in 

sequential. 

 

Optimization is a three step process: 

 First, a basic lens design is entered which has the correct field of view, wavelength, system 

aperture, number of surfaces, etc. This system should be traceable without error. 

 Next, some parameters in the Editor are defined as variables. This means that OpticStudio 

can change the value of these variable parameters in order to better meet the design 

specification. 

 Last, the design specification is expressed as a series of design goals called a merit function. 

The merit function ultimately is expressed as a single number, and the closer to zero this 

number is, the closer the design is to your desired performance. 

Optimization then changes the values of the defined variable parameters so that the merit function 

is reduced to its minimum value. OpticStudio contains several different optimization algorithms, two 

local optimizers and two global optimizers. In this example we will use the Damped Least Squares 

local optimizer, and the Hammer global optimizer. 

Also, this three-step optimization process may be repeated several times during the design process. 

After optimization, the system performance may still not be as required, and more lenses may be 

needed, or you may choose to make some surfaces aspheric and repeat the optimization with the 

aspheric parameters set as variables. 

Tutorial 5.1: The Lens Specification 

 

Here is the specification of the lens we are to design: 
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Design a cemented doublet that works at f/5 over the visible region of 

the spectrum. The field of view is 10° full field of view, and the object 

is a very long distance away from the lens. The lens aperture is 25 mm 

entrance pupil diameter, and the lens must be at least 2 mm wider in 

diameter than the optical beam to allow for mounting clearance. 

 

Tutorial 5.2: Entering the Basic System 
in the System Explorer 

 

Press File…New to clear OpticStudio and start a new design. We will start by defining the incoming 

light, by its aperture, wavelength, and field of view. All of this is defined in the System Explorer 

sidebar. 

 

The system aperture has been defined as 25 mm entrance pupil diameter, with at least a 27 mm 

mechanical diameter to allow for mounting of the lens. In the System Explorer Aperture Group, 

enter the Entrance Pupil Diameter as 25: 

 
Lens units are millimeters by default, which you can confirm by clicking on the Units tab of the 

dialog box. We also have a requirement for the lens to be mechanically 2 mm larger in diameter 

than its working aperture, so click on the Miscellaneous tab and enter a 1 mm semi-diameter 

margin like so: 

 



 

Zemax, LLC Getting Started With OpticStudio 15 Tutorials    80 

 
  

Note that OpticStudio works with semi-diameters, not diameters, so a 1 mm semi-diameter margin 

gives a 2 mm diameter margin. 

 

We will now define the wavelength of the light. This specification is a little vague on this important 

system parameter. For example, what is the ‘visible spectrum’, and at exactly what wavelength 

should the system be f/5? We will assume that the ‘visible’ region is that covered by the F, d and C 

spectroscopic lines. This is a very common assumption in visible system design. We will further 

assume that the d-line, being the central wavelength, should be the wavelength at which the f/# of 

the lens is defined. We will therefore enter the System wavelengths as follows  

 
  

In the drop-down list next to the ‘Select’ button, choose the spectrum “F, d, C (visible)” and press 

the Select button to copy this spectrum into the Wavelength Data dialog. This sets three 

wavelengths, in ascending order, and sets wavelength #2 as the primary wavelength. 
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Note: In real life, any time you find yourself making assumptions about what specifications mean, 

always refer back to the customer! Part of your QA process should be to do a point-by-point 

comparison of each specified parameter, how it has been entered into OpticStudio and how it will be 

tested in the built system. 

 

Last, we will define the field of view, which is 10° full field of view, hence 5° half-field. In the Field 

section, click on Add Field: 

 
And enter the new field point like so: 
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Alternatively, just double-click on the ‘Fields’ line at the top of this section, and enter the data 

though a standard dialog box: 
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Note: As the lens is rotationally symmetric we do not need to specify a field point at y = -5°, or at x = 

5° or -5°. Always define your field points in +y only unless you specifically require a non-rotationally-

symmetric lens system. We have now entered everything we need about the light coming into the lens: 

its diameter, wavelength and field of view.  

 

Tutorial 5.3: Entering the Basic System 
in the Lens Data Editor 

 

We now need to enter the first-guess data for the optical surfaces in this lens system. As we know 

we will be designing a cemented doublet, we know we will need a total of six surfaces: the OBJECT 

surface, STOP surface, the front, middle and rear doublet lens surfaces and the IMAGE surface. Go to 

the Setup Tab, and click the Lens Data icon in the Editor group. Click on the IMAGE surface in the 

Lens Data Editor, and press the Insert key 3 times to insert the correct number of surfaces, and enter 

the following data: 
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Note: If you are using the demonstration version, OpticStudio will display fewer decimal places. This 

does not affect the accuracy of the calculations or results. 

Because the specification says that the OBJECT scene is ‘a very long distance’ away from the lens we 

have set the OBJECT surface thickness to ‘Infinity’. You do this by typing the word “Infinity” or just 

the letter “i” (without the quotation marks) in the editor cell. 

 

Do not enter anything in the semi-diameter data column. OpticStudio will work this out for you, and 

include the requested margin so that the lens is larger than the incoming beam. Use the Cross-

section layout (in the Setup and Analyze tabs) to show the design so far: 
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Now our system has a requirement that it must be f/5. There is a simple way to achieve this, click 

the cell to the right of the radius of curvature cell of the last lens surface, and choose an f-number 

solve like so: 
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OpticStudio will immediately compute the radius of curvature that yields an f/5 cone of light: 

 

 
  

Try altering the radii of curvature of the other two surfaces, and you will see that the f/# solve 

automatically updates to enforce the condition that the lens be f/5. A solve is the most efficient way 

to enforce a system constraint. 
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Note: Read the “Solves” section of the Technical Reference in its entirety. A solid understanding, and 

use, of solves is one of the hallmarks of the professional lens designer! 

 

Now we will bring the lens into focus. Go to the Optimize tab, and in the Manual Optimization tab 

choose the Quick Focus icon: 

 
and set it up like so: 

 
  

Update the cross-section window to see the final ‘basic setup’: 

 



 

Zemax, LLC Getting Started With OpticStudio 15 Tutorials    88 

 
  

  

So now we have an f/5 lens, operating over the visible with a 5 degree field of view. Open a spot 

diagram by clicking on the Standard Spot Diagram in the Rays and Spots menu of the Analyze tab: 
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The RMS spot radius is 143µ on axis, and about 169µ at the 5° field point. Check that you get the 

same data as shown here, and if not go back through the exercise step by step to make sure your 

system is correctly set up.  

 

Note: Finally, click on Setup Tab…System Check in the ‘Diagnostics’ group. This invaluable utility 

checks your file for the most common setup faults. Although not every possible fault can be caught by 

such a utility, anything it does report should be checked, and anything classed as an ‘Error’ must be 

rectified before proceeding. 

 

Then click on File…Save As, to save the file as ‘basic setup.zmx’. 

 

Setting Variables 

Our basic system setup is certainly an f/5 lens that meets the specification of aperture, wavelength 

and field of view, but it is not necessarily the best possible lens for the job. In fact, with only one 

curved surface, it is highly unlikely to be the best possible lens for the job! We are now going to 

optimize the lens to get the best possible performance.  

 

First we will tell OpticStudio what it may change. We do this by clicking on the cell to the right of 

the parameter we want, and selecting the ‘variable’ solve: 
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Or we can highlight the cells we want OpticStudio to change the values of, and use the keyboard 

shortcut <Cntl>Z (press and hold the Cntl button, and then press the z button on the keyboard): 

 

 
Or, in the Automatic Optimization group of the Optimize tab, we can use set all radii variable/set all 

thicknesses variable: 
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To set a total of six variables: 

 
  

The status flag V indicates variables that OpticStudio may change the values of, just as the F flag 

means that the rear surface’s radius of curvature is set by an f/# solve. As OpticStudio modifies the 

values of the variables, the f/# solve will automatically update to maintain the lens at f/5.  

 

Defining the Merit Function 

Next we will build the merit function for this design. In the Optimize tab, click on Optimization 

Wizard in the Automatic Optimization group: 
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This will open the Merit Function Editor, and also activate the Optimization Wizard in the Property 

Inspector area of the Editor. Because this is a focal system, we want the smallest RMS spot radius, 

choose RMS Spot Radius, relative to the centroid, and set the number of rings to 4 (we will discuss 

this in more detail later, for now just make these changes) and press the OK button to close the 

Optimization Wizard: 

 

 
  

OpticStudio will then write out a merit function like so: 
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Each row in the Merit Function Editor contains an operand, which computes some value. The TRAC 

operand, for example, computes the radial point at which a specified ray lands on the image plane, 

relative to the average of all rays from that field point. Note that each TRAC operand traces a ray 

defined by its wavelength number, and its (Hx, Hy, Px, Py) normalized coordinates. Different 

operands will take different arguments, and the names of the arguments are given in the header 

row of the Editor. 

 

Each operand that computes a value returns that value in the ‘Value’ column of the editor. The 

operand is also given a target value to achieve, and a weight. The merit function value is then 

computed as: 

 
 

where Wi is the weight of the ith operand, Vi is its computed value and Ti is its target value, and the 

summation is over all the operands in the merit function. As the computed values of the operands 

move towards their target values, the merit function value approaches zero. Because the difference 

between the target and actual values of each operand is squared, any deviation from the target 

value yields an increasingly positive value of the merit function. 

 

Note: The goal of the optimizer is to reduce the merit function to zero, or as close as possible, by 

adjusting the values of the variable parameters in the Lens Data Editor. 
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Optimizing the Lens 

 

Now that we have defined the variables and the merit function, click the Optimize! icon in the 

Automatic Optimization group 

  
 

And then press the Automatic button. Note that the optimizer is multi-threaded and will split the 

calculation over all the CPUs in your machine if that will speed the calculation up.  

 

 
 

The merit function value quickly falls, and the Spot Diagram plot shows the improved performance 

(double-click it to make it update). The RMS spot radius is now 11µ on axis, and about 20µ at the 5° 

field point, compared to 143µ and 168µ prior to the optimization. That’s a big improvement!  
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However, there is a clear problem, which can be seen in the Layout plot: 

 

 
  

The lens is unfeasibly thick! We have told OpticStudio to minimize the RMS spot radius, but have 

given it no guidance about any constraints it must operate within. Press the F3 button, or click on 

the Undo icon: 
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This will undo the optimization and restore the previous, un-optimized system. Click on the 

Optimization Wizard again (it is in the Merit Function Editor toolbar as well as the Optimize tab) and 

set up the following changes 

 

 
  

These settings require that the lens elements have a center thickness somewhere in the range 

between 2 and 20 mm, and that the lens edge-thickness be greater than 2 mm (this is a useful 

constraint to aid manufacturability). Any surfaces made of air must have thicknesses between 0.5 

and 1000 mm, which is not necessary in this design, but in a multi-element design will prevent lens 

elements from hitting each other or being unreasonably far away from each other, and is therefore 

added here for completeness.  

 

Click OK to enforce the changes. Press the Optimize! icon again, and we get a much better design: 
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And the RMS spot radius is now 13.6µ on axis, and about 26.1µ at the 5° field point: 

 
  

Note: The key point is that for successful optimization, the merit function should contain both the 

optical targets you want to achieve, plus constraints that will prevent OpticStudio from producing 
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unwanted design shapes. Typical constraints include the thickness of elements, weight, maximum 

acceptable distortion, etc. 

 

Are There Enough Field Points? 

 

We optimized this lens using just two field points, at 0° and 5°. Although the RMS spot radius looks 

well controlled at these two points, how do we know that at some intermediate field point the 

performance of the lens does not degrade?  

  

In the Analysis tab, click on RMS…RMS versus Field: 
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This plot shows how the RMS spot radius varies as a function of field, with field as a continuous 

variable. We are using 15 points across the 5° field, and plotting the RMS spot radius for each 

wavelength individually and as a polychromatic average. Note that the RMS spot never exceeds its 

value at the extreme fields of 0° and 5°. Therefore, two field points provide adequate control in this 

design. If the curve shows exceeds the value at the maximum or minimum field points, add more 

field points as required. 

 

Note: If you change the number of field points, or the number of wavelengths, you must rebuild the 

merit function to include your changes into it. 

 

A similar RMS vs. Wavelength plot allows you to check that you have adequate control with the 

defined number of wavelengths, as does Analyze… Aberrations…Chromatic Focal Shift and 

Analyzed…Aberrations…Lateral Color. 

 

Another excellent way to look at the optical behavior over field and wavelength is to use 

Analyze…Extended Scene Analysis…Image Simulation. Configure it like so: 
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This will produce a simulation of what a real source scene, described by an input bitmap, will look 

like when imaged by the lens. This analysis is amazingly fast, taking literally only a few seconds to 

produce the image below. This feature is ideal for communicating real-world optical performance to 

non-optical specialists. 
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Glass Optimization 

There is an important difference between optimizing glasses and other system parameters. 

Parameters like radii of curvature, thicknesses, etc. can be smoothly varied: a thickness of 10.0 mm 

can become 10.00001mm for example. However, glasses are only available with discrete properties: 

you cannot simply perturb a glass to get a slightly different refractive index! Instead, we use a 

method called Glass Substitution to swap out the glasses that the design currently uses for other 

glasses. 

 

The first step is to define a template for the glasses OpticStudio is allowed to choose. Within the 

Optimize tab, choose the Glass Substitution Template from the Global Optimizers group: 

 
And configure it like so: 
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We are telling OpticStudio to use only Preferred optical glasses (a status flag that indicates the glass 

is easily available and does not have any unusual properties). In addition, each glass must cost no 

more than 10 times the price of N-BK7 (the relative cost), and must have a Climate Resistance factor 

of 2 or better and a Stain Resistance factor of 1 or better. There are a total of 58 glasses in the 

currently loaded catalog (by default the Schott glass catalog is loaded) that meet these criteria, and 

these are the only ones that will be selected for substitution. 

 

Then click on the cell top the right of the material of surface number 2, which is currently N-BK7, 

and in the solve dialog box set a ‘Substitute’ solve: 
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Repeat this for the F2 on surface 3. The Lens Data Editor should show an S status next to the 

glasses, to indicate that these glasses may be substituted: 

 
   

The glass substitution method is too complex for the local optimizer. Instead, use the Hammer 

optimizer in the Global Optimizers group and OpticStudio will quickly find the best glasses for this 

design: 

 

 
  

Check the glasses in the Glass Catalog to ensure they meet the specification (click on the glass, and 

go to Libraries…Materials Catalogs). The design now has an RMS spot radius below 19µ everywhere 

across the field of view:  
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Tutorial 5.4: Tips and Tricks for 
Successful Optimization 

The following tips and tricks are useful guidelines for how to make the best use of OpticStudio’s 

wide and powerful optimization features. 
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Use Physically Significant Merit Functions 

Before you start to design your lens, think about how it will be tested and used. Test methods fall 

into a number of broad categories: 

 Imaging onto CCD arrays or (less common) photographic films. RMS Spot Radius is usually a 

good performance indicator in this case. If the final system is expected to have less than 

about 2 waves of aberration, use RMS Wavefront Error instead. 

 If you will test your lens on an interferometer, optimize for RMS Wavefront error. 

 If you will test your lens on an MTF measurement rig, use RMS wavefront error. MTF 

improves as RMS wavefront error approaches zero. If you need further improvement, use the 

various MTF* operands described in the Optimization chapter of the Technical Reference to 

target MTF performance at specific spatial frequencies. 

 If you are designing an afocal system like a beam expander, switch the lens to Afocal Mode 

via the switch on the System Explorer’s Aperture section. Use RMS Angular Radius if you 

expect more than about 2 waves of aberration in the final system, and RMS wavefront error 

if you expect less than 2 waves of aberration. 

 

Don’t Optimize Aberration Coefficients 
Directly 

It is tempting to attempt to ‘control’ the lens under optimization by targeting Seidel aberrations like 

SPHA, COMA, etc. directly in the merit function, and then using fifth-order aberrations for better 

control (see the macro fifthord.zpl, or the optimization macro ZPL03.zpl for example). While this is 

perfectly possible to do in OpticStudio, we do not recommend it, for the following reasons: 

 Aberrations are difficult to compute in tilted and decentered systems, or systems with 

components like aspheric surfaces, diffractive components or GRINs. 

 The Gaussian Quadrature (GQ) method OpticStudio uses for RMS Spot Radius and RMS 

Default Merit Functions are exact to a specified order of wavefront aberration. If you use n 

rings in the default merit function, you then have control of all wavefront aberrations up to 

order r(2n-1). In the doublet lens we designed, we used 4 rings and therefore could control all 

aberrations up to r7, which is a higher order than fifth order aberrations can achieve. See G. 

W. Forbes, "Optical system assessment for design: numerical ray tracing in the Gaussian 

pupil", J. Opt. Soc. Am. A, Vol. 5, No. 11, p1943 (1988) for a very readable and full account of 

this useful technique. 

 We are usually interested in optimizing for real-world performance metrics like spot size, 

wavefront error, MTF, etc. Fifty years ago aberration theory was a useful computational 

shortcut, but 21st century computers and multi-threaded software like OpticStudio are 

massively faster than the tools available then. Optimizing directly for the desired 
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performance is more practical than optimizing for some intermediate function that we hope 

will then go on to give us the desired performance. Optimize for what you want to test the 

built system for! 

 Note for example that in the optimization of the doublet we did not need to target 

chromatic effects like axial or lateral color directly: the default RMS spot radius merit 

function provided this automatically. 

 The exception to this is distortion, because distortion affects only the location of the image, 

not its quality. Operands like DIMX, DISG, etc. can be used to control distortion.  

Use the Optimization Wizard 

We recommend that you use the Optimization Wizard as the foundation of your merit function 

construction. This generates a ‘Default Merit Function’ which is the bedrock of your optimization 

function. Ultimately imaging systems are characterized by RMS spot radius or wavefront error, and 

afocal systems by RMS angular radius or wavefront error. The Optimization Wizard also automates 

the construction of the most common opto-mechanical constraints designers require, such as lens 

edge and center thickness constraints. 

 

Additional goals and constraints can be easily added by inserting your own operands above the 

Wizard’s operands in the editor. OpticStudio writes out the dummy operand DMFS (Default Merit 

Function Start) to indicate where the default merit function starts, and you should not hand-edit the 

operands below this line. Just click on the DMFS operand and press the insert key to insert new lines 

above the default merit function. 

Use Hammer Often 

The Hammer optimizer is used to improve a lens that has already been optimized by the local 

optimizer. Get in the habit of leaving the Hammer to run on an optimization problem when you are 

working on something else. The Hammer can be left to run overnight, or over weekends or even 

weeks if necessary. 

Use Adequate Boundary Conditions 

You should always add boundary constraints to your merit function, as well as optical targets. This 

yields two important benefits: 
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 OpticStudio will produce designs you can build, and that meet your non-optical goals! For 

example you should always constrain edge and center thicknesses of lenses to be 

reasonable, and you can add constraints on length, weight, etc. as required by your 

application. 

 Good boundary constraints speed up the global optimizers because OpticStudio does not 

look in regions of parameter space where the boundaries are violated. This can speed up 

Global Search in particular by orders of magnitude. 

Use the System Check Utility 

The System Check utility, on the Setup tab, is an invaluable aid to ensuring there are no accidental 

errors in the system setup. Although not every possible fault can be found by such a utility, anything 

it does report should be checked, and anything classed as an 'Error' must be rectified. 
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Tutorial 6: Non-Sequential Ray 
Tracing (Professional and Premium 
only) 

 

Note: Even if you intend to use only the non-sequential mode of OpticStudio, you should work through 

the previous tutorials before starting this one. Sequential and non-sequential modes share many 

common user interface concepts and methods which are described in those chapters and are 

not repeated here. 

 

Non-sequential ray-tracing is a powerful and general technology for tracing rays in systems where 

there are multiple optical paths. Typical uses include:  

 

 Illumination systems, especially those with multiple or complex optical sources  

 Systems such as interferometers, in which light that has travelled through several different 

optical systems must be coherently recombined  

 Opto-mechanical stray light analysis in otherwise sequential optical systems 

 LCD backlighting 

 Bio-optical systems, particularly those based on scattering from tissue or fluorescent 

scattering 

 

Non-sequential ray tracing assumes that there is no pre-defined path for any ray. A ray is launched 

and hits whatever object is in its path, and it may then reflect, refract, diffract, scatter, split into child 

rays, etc. It is a far more general technology than sequential ray-tracing, and is therefore somewhat 

slower in terms of ray-tracing speed but more general in its scope.  

 

Sequential designs can be converted easily to non-sequential mode by using Convert to NSC Group 

on the File tab. 

 

Tutorial 6.1: A Simple Example 

 

Click on File…New to start a new OpticStudio design. Then click on Setup…Non-Sequential UI Mode. 

A new editor, the Non-Sequential Component Editor, (NSCE) will appear. The Analyze and 

Tolerancing tabs are not the same as in sequential mode. 
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The NSCE is very similar to the Lens Data editor or the merit function editor in look and feel, and if 

you know how to use these editors the NSCE holds no surprises. The NSCE consists of a toolbar, 

Property Inspector and spreadsheet region, just like the other Editors 

 

 
 

However, in non-sequential mode we deal with ‘components’ or ‘objects’ rather than ‘surfaces’. 

Objects are full 3D volumes, not a collection of individual surfaces. 

 

There are three basic types of object: 

 

 Source objects, from which rays are launched into the non-sequential system 

 Geometry objects, which define the optical components (lenses, prisms, mirrors, CAD 

objects, etc.) that the rays reflect, refract, scatter or diffract from 

 Detector objects, which detect rays and give quantitative data of optical performance like 

irradiance, radiant intensity etc.  

 

Open the Properties Inspector for Object 1 in the NSCE: 
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Select ‘Objects’ to restrict the listing to geometry objects, and select ‘Standard Lens’ from the list: 

 
And close the Property Inspector. Note you can also just type directly into the Object Type cell in 

the editor, or use the drop-down list: 
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 Open a Shaded Model plot to see the object and use a Y|Z cutting plane to make the layout more 

meaningful. 

 

 
 

Note that you have a single ‘Standard Lens’ object that defines the entire object, rather than two 

surfaces and a thickness. Looking at the editor, you can position this object at any (x, y, z) location, 

and tilt it about x, y, z. You can then enter the glass type the object is made from, and its defining 

parameter data. Enter the following data: 

 
All positions and tilts: 0.0 
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Material:     N-BK7 

Radius 1:     5.0 

Conic 1:    0 

Clear 1, Edge 1:    both 1.0 

Thickness:    1.0 

Radius 2:     2.0 

Conic 2:     0 

Clear 2:     0.8 

Edge 2:     1.0 

 

You should see this: 

 
This is a fully parametric lens, modeled as a solid object and not a collection of surfaces. 

 

Next, click on the lens object in the editor again and press the Insert button to create a new ‘Null 

Object’ and make it a ‘Source Ray’ object.  
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Enter the following data: 

 
All parameters are 0.0 except: 

Y position:   0.5 

Z position:   -1.0 

Tilt About X:   15.0 

Layout Rays:   1 

 

You will then see this ray-trace like so: 

 
 

You may have to adjust the slicing plane manipulator slightly to see the whole ray trace. The ray is 

traced from the source to the front face of the lens, and then onto the second face of the lens. As 

there is no further object for the ray to hit, OpticStudio draws it for a short distance and then stops 

tracing it. 

 

Now click on the row number of the Source Ray object to select the whole row, right mouse click 

and select ‘Copy Object’. 
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Click on the row again so it is no longer highlighted and press <Cntl>V or right-mouse click again 

and select Paste Object to paste the object back into the editor as a new object. You should now 

have two identical source objects. Modify the parameters of one of them as follows: 

 
Z position:  2.0 

Tilt About X:  -15.0 

Tilt About Y: 180.0 

 

Do not change any other parameters. Update the layout as you make each change so you can see 

what is happening. You should see two sources, one on either side of the lens.  
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Now, on the Settings of the Layout plot, select the options to ‘Split Rays’ and ‘Fletch rays’: 
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This simple example shows the key benefits of non-sequential ray tracing: 

 

 You do not have to tell rays where to go. Rays are launched and then interact with whatever 

objects are in their path. 

 When a ray hits a refractive object, part of its energy is reflected and part is transmit-ted. 

OpticStudio can produce ‘child’ rays that take the reflected energy, and these child rays then 

interact with whatever is in their path, and in turn produce children of their own, which can 

have children of their own, etc. 

 As well as being partially reflected and refracted, rays can also scatter at the surface of an 

object or inside its volume (called bulk scattering to distinguish it from surface scattering). 

 Sources, objects and detectors are placed in a global coordinate system, and can be 

positioned and tilted independently of each other. In addition, if it is required, objects can be 

positioned relative to other objects, which we will discuss later. 

 

Because rays can be split into transmitted, reflected and scattered components, as each ray splits it 

contains less and less energy. We need to put some limits on the ray-tracing to prevent OpticStudio 
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from tracing rays with insignificant amounts of energy. This is defined in the System Explorer, in the 

Non-Sequential grouping: 

 

 
  

Try varying this parameter and observe how it affects the number of child rays produced. Set it to 

10-2 and note you get fewer rays; at 10-12 you will get many more. 
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Tutorial 6.2: Object Positioning & 
Definition 

 

The Non-Sequential Component Editor provides an easy way to define the non-sequential optical 

system, and the inter-relationships between components. Open the sample file in the Samples\Non-

sequential\Miscellaneous folder called “Digital Projector Flys Eye Homogenizer.zmx”. The system 

contains an elliptical source volume that approximates the shape of the fireball in an arc lamp inside 

a parabolic mirror. The output light enters a homogenizing optical system that consists of two fly’s 

eye lenslet arrays and a field lens. The homogenizer is manufactured as a complete sub-system 

which is then placed into the optical beam produced by the source and parabolic mirror.  

 

 
 

Object Positioning 
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Note how the objects are referenced: 

 

 
  

Every object has a number, shown in the left-most column of the editor, and a ‘Reference Object’. 

Ref Object 0 is the global coordinate reference point of the whole 3D space, and objects 1, 2 and 3 

are positioned relative to this coordinate system. Objects 4, 5, 6, and 7 are positioned relative to 

object 3, and they therefore are positioned like a sub-assembly: try moving object 3, and notice that 

objects 4-7 automatically move as well. So the position of object 3 defines the position of the 

homogenizer assembly. 

 

Note: Any object can be positioned relative to any prior-defined object, which can be positioned 

relative to any other object defined prior to it, etc. 

 

Imagine we now want to move the homogenizer about some arbitrary point. Click anywhere on 

object 1, and press the Insert key, so that you now have a ‘Null Object’ as object 1, and all other 

object numbers have automatically incremented. The Lenslet Array object that serves as the 

reference for the homogenizer assembly is therefore now object 4. 

 

Null objects have no optical properties, and so they are useful for defining reference and pivot 

points, for example. Position the null object at y = 40, z = 70, and then double-click on the object 

type to show the object properties tab: 
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On the Draw tab, check the ‘Draw Local Axis’ control. On the NSC 3D Layout, the Null object’s local 

axes are now drawn (note that local axes are never drawn in the Shaded Model). 

 

 
  

On the Non-Sequential Component Editor’s toolbar, choose the Modify Reference Object tool: 

  



 

Zemax, LLC Getting Started With OpticStudio 15 Tutorials    121 

 
 

 

And set it like so: 

 

 
  

OpticStudio will now modify object 4’s properties so that it is positioned relative to object 1, while 

retaining its absolute position and orientation in global coordinates. In other words, object 4 has 

not moved, but its position is now defined relative to a different object. The subsequent objects are 

still positioned relative to object 4: 
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If you now apply a Tilt About X of 10 degrees to object 1, you will see that the whole homogenizer 

assembly pivots about object 1, but the lamp assembly remains in place: 
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Object Parameters 

 

As well as being positioned, objects are given their defining parameters in the NSC Editor. For 

example, the Lenslet 2 object is defined by parameters like x and y halfwidths, thickness, radii of 

curvature and conic constant, and numbers of lenslets in x and y. 
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There is a great advantage to this parametric approach. Parametric objects require relatively little 

memory, are fast to ray-trace, and can be changed easily. They are also optimizable, just like 

sequential surfaces. 

Further, interrelationships between objects can be easily defined via pickup solves. Note that the 

second lenslet object uses pickups on several parameters to lock itself to the first lenslet object 

(Note the letter P on some of the defining properties of this lens, which denotes a pickup solve). 

This is a great advantage during optimization, as changes to one parameter can automatically flow 

through the whole system. 

 

Tutorial 6.3: Combining Sequential and 
Non-Sequential Ray-Tracing 

 

Most imaging systems are well described by the orderly sequential approach used in the Lens Data 

Editor. However, there are cases where an otherwise sequential system has some region in which 

there is a need for non-sequential ray-tracing. Prism assemblies are a classic example, in which 

different parts of the beam interact with different faces of the prism(s) in a different order to other 

parts of the beam.  

 

For example in Samples\Sequential\Afocal\Binocular_System.ZMX: 
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We have a classic sequential doublet objective and a Kellner eyepiece, just like any other sequential 

system. Note that a special sequential surface type called a Non-Sequential Component is used 

between the lens and eyepiece. This acts like the ‘entry port’ into the non-sequential world defined 

in the non-sequential component editor.  

The parameters on the Non-Sequential Component surface in the Lens Data Editor define the 

location of the ‘exit port’, which is how rays come back to the sequential ray tracer. This is referred 

to as ‘hybrid’ or ‘mixed’ Sequential\Non-sequential ray tracing. 

 

When a sequential ray hits the Non-Sequential Component surface in the Lens Data Editor, it is 

passed to the non-sequential ray-tracer and it interacts with whatever objects are defined in the 

NSC Editor and are in the ray’s path. When the ray hits the region defined by the exit port in the 

Lens Data Editor, it is transferred back to the sequential ray-tracer and interacts with the subsequent 

sequential surfaces. 

 

Note: Sequential rays cannot split inside the non-sequential group. 
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A sequential system can contain any number of Non-Sequential Component surfaces. The objects 

‘inside’ each Non-Sequential Component group are independent of each other. You can easily 

switch between non-sequential component groups by clicking the Surface in the NSCE menu bar. 

This surface corresponds to the surface number of the NSC group in the Lens Data Editor, and is 

only shown if there is more than one NSC group inside the Lens data Editor. 

 

 
  

If a ray does not hit the exit port, it is terminated and it does not return to the sequential ray-trace.  

 

Note: If the marginal and chief rays are not traceable through NS groups, OpticStudio cannot compute 

important sequential parameters like pupil positions and f/#. 

 

Tutorial 6.4: Tracing Rays and Getting 
Data 

  

Ray tracing in hybrid non-sequential mode works exactly as it does in sequential mode, except that 

there is no paraxial ray-tracing inside an NS group. In pure non-sequential we use source objects to 

launch rays and detector objects to get quantitative information. 

 

Source Objects 

 

Source objects are objects that launch rays into the optical system with the appropriate spatial and 

angular distributions to represent the radiance of the real sources in your system. 

 

Source objects fall into two categories: 
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 Parametric sources, like the Source Diode or Source Filament, in which the source radiance is 

computed from some equation, and you enter the parameters for this equation via the 

editor. 

 Measured sources, like the Source IESNA, Source EULUMDAT, and Source File. Note that 

IESNA and EULUMDAT data files contain only far-field (angular) data and model the source 

as a spatial point. The .DAT and .SDF formats, used by the Source file object, contain both 

spatial and angular ray data, and so define the full radiance of the source. Data in these 

formats are provided free by many LED and lamp manufacturers, and can also be exported 

by third party programs like Radiant Zemax’ ProSource and Opsira’s Luca Raymaker. The 

.DAT and .SDF formats are documented in the Users' manual in both ASCII and binary 

formats. The difference between the two formats is that the .SDF format contains spectral 

(wavelength) data, whereas the .DAT format does not. 

 

Source wavelengths are defined in the System Explorer Wavelength group, just like sequential 

systems, although other definitions are also available, and will be discussed later in the section on 

Colorimetry. Source Units (Watts or Lumens) are chosen under the System Explorer Units group. 

 

Sources are positioned in global coordinates in exactly the same way as any other object. All 

sources use parameters 1-5 of the Non-Sequential Component Editor to define some basic 

information about the source. These are:  

 # Layout Rays: Defines how many random rays to launch from the source when creating 

layout plots. This is typically a small number, say less than 100,  and is used only for drawing 

purposes. 

 # Analysis Rays: Defines how many random rays to launch from the source when per-

forming analysis. This is typically a much larger number and may be millions or even billions 

of rays. 

 Power (units): Power is the total power over the defined range of the source. The power units 

are specified by the system source units in the System Explorer. 

 Wavenumber: The wavenumber to use when tracing random rays. Zero means poly-

chromatic, which chooses ray wavelengths randomly with the weighting defined on the 

wavelength data editor. 

 Color #: The pen color to use when drawing rays from this source. If zero, the default color 

will be chosen. The RGB values of each pen are defined under Project Preferences. 

 

Parametric sources will then use further parameters to define their radiance. 

 

Source objects are not made of any material. Rays, once launched, have no further interaction with 

source objects. Rays are normally launched into air, but can be launched inside some other 

refractive index if desired. Define a geometry object with the correct shape and refractive index first 

and then locate the source object inside it, and then use the “Inside Of” parameter to tell 

OpticStudio to launch the rays inside that object’s refractive index. 

 

Note: Source objects must use the Inside of parameter when the source is placed inside a geometry 

object, otherwise incorrect ray-tracing will result. 
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Detector Objects 

 

Rays are detected by Detector objects. Almost any kind of geometry object can be used as a 

detector also, but the dedicated Detector objects are designed for the task of displaying spatial and 

angular data and provide the controls users need to represent data the way it is measured 

experimentally. 

 

The most common type of detector object is the Detector Rectangle. This is a two-dimensional array 

of pixels, similar to a CCD array. It is most commonly used with the material ABSORB, so that rays 

terminate upon being detected, but it can also be set as a MIRROR (with coating, if required, to be 

discussed later), or its material may be left blank to indicate air. Note that when the material is left 

blank, rays are not perturbed in any way by being detected. This can be useful, but care must be 

taken as the detector may appear to not conserve energy if a ray interacts with it multiple times 

without losing any energy! 

 

Tracing Analysis Rays 

 

Open the sample file Samples\Non-sequential\Sources\Simple LXHL-BD01 LED model.ZMX. This file 

contains just two objects, a Source Radial set with data taken from the LumiLeds LXHL-BD01 LED 

datasheet, and a Detector Rectangle set to 100 by 100 pixels. 

 

Note that the source object has a total power of 27 Lumens, uses 30 layout rays for drawing 

purposes, and uses 1 million Analysis rays. In the Analyze tab, click the Ray Trace icon: 
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Click Clear and Trace to trace the million Analysis rays, then click Exit. If you have more than one 

CPU in your computer, the calculation will be automatically split up over all available CPUs.  

 

Click on Analyze…Detector Viewer to see the data inside the Detector.  
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The Settings dialog for the Detector Viewer is very powerful, and allows you to select incoherent 

illuminance, Luminous intensity, coherent illuminance and phase (not meaningful in this case) and 

luminance. Multiple Detector Viewer windows can be open simultaneously to display multiple views 

of the same data.  
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You can also show the data in false color, grey scale or look at cross-sections through the data 

using the ‘Show As’ control. When using cross-section views, row or column 0 always means the 

central row/column. Data can be scaled linearly or logarithmically. 

 

The data can also be smoothed by averaging the data in each pixel and its neighboring pixels. The 

operation can be repeated the number of times specified by the smoothing parameter. This 

improves signal/noise at the expense of spatial or angular resolution. 

 

Ray Databases 

 

The Detector Viewers are very useful, but sometimes you will want access to the ray data directly. 

Repeat the ray trace (press the Rtc button) and select ‘Save Rays’ 

 

 
  

Note that the ray-trace takes a little longer now because of the time taken to write one million ray-

histories out to disk. Then press Analyze…Ray Database Viewer:  
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The Ray Database Viewer shows the history of every ray traced. The intensity position, direction 

cosines, normals, path length and polarization data of every ray can be shown, although only 

intensity is shown here. The ray is broken down into segments, where each segment is a single ray-

object intersection. Segment 0 is the ray data at the source. Various parameters XRTS etc. show 

what happened at the end of the segment (X= terminated, R= reflected, etc.). This example is very 

simple in that rays are launched, traced once and terminated:  

 

 
 

In a more realistic system, there are many more segments, of course. Load the sample file 

led_model.zmx (in the same folder as the file we are currently using), trace Analysis rays using these 

settings: 
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Use the Ray Database Viewer to view the ray histories. Note that as ray splitting is on, you can use 

the option ‘expand into branches’ to identify each child ray separately. 

 

Filter Strings 

 

Because OpticStudio knows the history of every ray it has traced, we can use filter strings to identify 

rays that meet specific conditions easily. For example, in the led model.zmx file, object 2 is a 

reflector behind the source. Some rays are fired forwards, and never see this mirror, while others 

move in the opposite direction, hit the reflector, and then travel forwards:  
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Using the filter string R2 means that only rays that reflect from object 2 will be shown: 

 



 

Zemax, LLC Getting Started With OpticStudio 15 Tutorials    135 

 
 

!R2 will show those rays that do NOT reflect from object 2, i.e. rays that propagate forwards initially. 

You can AND, OR, NOT, XOR, etc., multiple filters to produce a filter string that identifies exactly the 

conditions you want to investigate. For example, to select rays that must have either a) hit object 7 

and object 9, but did not reflect off object 6, OR b) missed object 2, the filter string would be (H7 & 

H9 & !R6) | M2. 

 

Filter strings are your most important tool for detailed system analysis. They can also be used with 

ray databases, both prior to saving the ray-database and with the saved data. For example, in stray-
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light simulations you may have to trace millions of rays to get one that finds its way to the detector. 

By saving to disk only those rays that hit the detector, you can produce a manageable data set for 

further study. 

 

You can replay ray databases through the ray-database viewer, the layout plots, and the detector 

viewers, and add further filters to the filtered data. The ray database viewer will also let you filter a 

ray database and save the sub-set data into a new file. 

 

Tutorial 6.5: Complex Object Creation 

 

No matter how many objects we add to OpticStudio, you may still sometimes need an object that is 

not directly available. There are, however, ways to manipulate existing objects so as to create 

precisely what you need. 

 

The Overlapping Objects Rule 

 

When two or more objects occupy the same region of space, a simple rule applies. The properties of 

the common region are defined by whichever object is listed last in the Non-Sequential Component 

Editor. 

 

Open the sample file Non-sequential\Diffractives\Diffraction grating lens with hole.zmx. This mixed 

sequential/non-sequential design shows a lens with diffractive power, and a central region with no 

diffractive power: 
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This is easily achieved by placing the non-diffractive element after the diffractive element in the 

editor, and co-locating them. There is no need to use the ‘Inside Of’ flag when geometry objects are 

nested inside each other, unless a source object is inside one of the nested objects. Geometry 

objects may fully or partially overlap, but source objects must always be entirely inside of any object 

they are co-located with. The ‘Inside of’ flag must be used for all nested geometry objects as well as 

sources in this case. 

 

The Boolean Object 

 

Up to eight objects may be combined in any order by the Boolean object, and Boolean objects may 

be combined with other objects, including other Boolean objects. For example, the sample file 

Samples\Non-sequential\Geometry Creation\Boolean Example 2-  a lens with a hexagonal 

edge.ZMX shows how a hexagonal lens can be formed by the Boolean intersection of a lens and a 

hexagonal bar: 
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See any of the sample files in Non-sequential\Geometry Creation for further examples. 
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The Array Object 

 

The Array object allows you to make one, two or three-dimensional arrays of any object, for 

example an array of Boolean objects (Samples\Non-sequential\Geometry Creation\Array Example 3-  

an array of Boolean objects.ZMX) 

 

 
  

Using the Array object is highly recommended over the alternative method of multiple object 

definitions for several reasons: 

 

 It uses much less memory than the equivalent number of individual objects: typically only 

slightly more than one instance of the parent object 

 It employs sophisticated ray-trace acceleration techniques to trace orders of magnitude 

faster than the equivalent number of individual objects 

 It is less error-prone than entering multiple objects, and only one object needs to be 

updated or optimized to update or optimize the whole array 
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The Array Ring can also be used to create circular, hexapolar, and spiral arrays. It has the same 

advantages as the Array object, outlined above. The sample below is Samples\Non-

sequential\Geometry Creation\Ring Array Example 3- Hexapolar Array.ZMX 

 

 
 

The Source Object 

 

Any geometry object may be used as a source by using the Source object. This is ideal for infra-red 

and Narcissus analysis, where the emissivity of opto-mechanical components must be accounted 

for. 
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Tutorial 7: Optimizing Non-
Sequential Systems 

 

Optimization is fully supported in both pure non-sequential and hybrid non-sequential/sequential 

optical systems. The most common way to optimize a pure non-sequential system is via the 

Optimization Wizards, which can then be modified with specific requirements. OpticStudio supports 

three Wizards for non-sequential designs: 

 

 
 

The most common operands used in non-sequential ray tracing are the NSTR and NSDD operands, 

although other operands are also available. NSTR is used to trace rays, and it acts exactly like the 

Ray Trace Control dialog. 

NSDD is used to clear detectors and to read out detector data. Any pixel can be read out directly, 

but for optimization it is usually more useful to optimize on aggregate ray data, like centroid 

location or effective widths in the spatial or angular domains. By using negative pixel numbers in the 

NSDD operand, OpticStudio will compute data like the average and standard deviation of all pixel 

data, and spatial or angular centroids and RMS widths.  
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Open the sample file in the Samples\Non-sequential\Miscellaneous folder called Freeform 

Optimization.zmx. This file contains a CAD part and source ray file supplied by Osram for their 

LB_T67c LED. It also contains a lightpipe, the shape of which we wish to optimize. 

 

Note that although the data file for the LED contains 50.7 lm (lumen) of power, we have set the 

Source power to be 1 lm. This has no effect on the rays traced other than a scaling of intensity, but 

it makes it easier to discuss efficiency as the total power is now 1 lm. 

  
 

The lightpipe is a Freeform-Z object, which is defined by a set of (y, z) data points. OpticStudio fits a 

smooth curve through these data points, and then rotates the curve around the z-axis to form a 

rotationally symmetric pipe. The pipe is currently just a cylinder, but note that the (y,z) data is set to 

be variable. 

 

Note also that the z-position, and x, y halfwidths of the detector object are locked to the Freeform-z 

object by pickup solves. These ensure that the detector will always be just in front of the output face 

of the lightpipe, as the pipe’s length is varied during optimization, and adjust the width of the 

detector so it always captures all the light from the output face as the width of the output face 

changes. 
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The primary goal for this light pipe is that it should give the highest brightness in the forward 

direction. Therefore its luminous intensity should be as high as possible and the width (in angle 

space) of the luminous intensity plot should be as small as possible. In addition, there are some 

mechanical constraints on the maximum and minimum widths and length of the lightpipe that must 

be met. 

 

Open the Merit Function Editor and examine the merit function. First the detectors are cleared, and 

then rays are traced. Then we compute the RMS angular width of the detector data by using pixel -9 

(which is RMS width) and Data = 2 (power/unit solid angle). The starting beam has an RMS angular 

width of 48.5°: 

 

 
 

and a peak luminous intensity of 0.38 lm/sr, although this is clearly a noisy number: 
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In addition, we also target the total power detected to be as large as possible. This is an important 

constraint, because if no rays land on the detector, the RMS angular width is identically zero! This is 

not a solution we want, so we are optimizing for maximum received power and minimum angular 

width. 

 

There are also some constraints on the shape of the pipe, and you should consult the full 

description of the FREZ operand for full details in the Help Files Optimize Tab chapter. These 

constraints prevent the lightpipe from becoming unfeasibly thick or thin. 

 

Run the optimizer, and select the ‘Orthogonal Descent’ optimization operand. This alternative local 

optimizer is very good at making big improvements quickly, especially in non-sequential systems, 

although the Damped Least Squares optimizer can usually make further improvements on it. 

  

After five cycles of optimization, the lightpipe’s shape has evolved to produce a peak luminous 

intensity of 102 lm/sr, which is over 200 times brighter than the starting design, and an RMS angular 

radius of less than 9°: 
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Note also that the detector object has shifted position and increased in size because of the pick-up 

solves used, and that the pipe is ~65% efficient (check the total power above and compare to our 1 

lm launch power) 
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Tutorial 8: Colorimetry 

 

Colorimetry is the study of color, which is the response of the human eye to optical radiation in the 

wavelength range 0.38 to 0.83 microns. The color of any non-sequential source object can be 

defined in many ways.  

 

If the wavelength spectrum of a source is known, and there is only one such spectrum it can be 

entered directly in the System Explorer’s Wavelength section (up to 24 data points). However, this is 

uncommon in colorimetry are other methods are more commonly used. In the Libraries tab, Source 

Viewers group, select the Source Spectrum Plot and look at its Settings: 
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The viewer is useful for investigating all the color models that OpticStudio supports, including those 

fitted from CIE color coordinates. Once you know how to define the colors you want, you enter this 

data within the Sources section of the Object Property Inspector: 

 

 
 

Any number of sources, each with its own unique color, can be defined. For example, if you have CIE 

1976 u’v’ data for a source where u’ = .31 and v’ = 0.5, OpticStudio can fit this color exactly using 

just four wavelengths: 



 

Zemax, LLC Getting Started With OpticStudio 15 Tutorials    148 

 
 

In general, you should use the minimum number of wavelengths that gives adequate color 

rendering. Rays are then traced using either the specified or synthesized spectra of each source, 

until they are detected by a Detector Color or Detector Polar object which can provide either True 

Color (photometric) or False Color (radiometric) data as required by the user.  

 

For example, open the sample file sub-folder \Colorimetry in the non-sequential samples folder, and 

open Example 1, two color mixing gives white. White LEDs can be produced by using two phosphors 

in the LED die, giving spectra in the blue and yellow. For simplicity, in this file we show the blue and 

yellow sources as being separate, and also as overlapping: 
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Note that because the two beams do not overlap perfectly, you can see a blue tinge on one side of 

the white spot, and a yellow tinge on the other. Optimization operands are available to allow each 

pixel's color to be analyzed and targeted in the merit function, so that you can optimize for a 

desired color or CRI. 

 

Tutorial 9: Polarization, Coatings & 
Scattering 

  

Ray tracing programs generally treat rays as purely geometric entities, which have only a position, 

orientation, and phase. For example, a ray is completely described at a surface by the ray intercept 

coordinates, the direction cosines which define the angles the ray makes with respect to the local 

coordinate axes, and the phase, which determines the optical path length or difference along the 

ray. 

 

At the boundary between two media, such as glass and air, refraction occurs according to Snell's 

law. Usually, the effects at the interface which do not affect beam direction are ignored. These 
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effects include amplitude and phase variations of the electric field which depend upon the angle of 

incidence, the incident polarization, and the properties of the two media and any optical coatings at 

the interface. 

 

Polarization analysis is an extension to conventional ray tracing which considers the effects that 

optical coatings and reflection and absorption losses have on the propagation of light through an 

optical system. It is available for sequential and non-sequential systems. 

 

Further, scattering at the interface can also be considered. Scattering is due to micro-structure of 

the surface texture: at a sufficiently fine resolution, the surface of a ‘smooth’, polished glass is really 

a rough surface, with the result that the departing direction cosines are perturbed, or scattered, 

about their specular values. Scattering can also occur during ray-tracing through an optical material, 

due to inclusions in the material. This is referred to as ‘bulk scattering’. 

Tutorial 9.1: Polarization 

 

In addition to position and direction, the amplitude and polarization state of a ray can be described 

by a vector E with complex valued components (Ex, Ey, Ez). Since the E vector must be orthogonal to 

the ray direction vector k, (given by the (l, m, n) direction cosines of the ray) then k.E = 0 and 

 

Ex.l + Ey.m +Ez.n = 0 

 

Since we know the direction cosines, we only need to specify the complex values of Ex and Ey, as Ez is 

then defined. The polarization can then be defined using a 2D Jones vector J = (Jx, Jy) where Jx and Jy 

are measured along the direction of the ray and have both a magnitude and a phase. The 3D E 

vector is then constructed from the 2D J vector and the direction cosines of the ray. 

 

The method used to define the initial polarization of a ray then depends on whether we are working 

with a sequential or non-sequential system. 

 

Defining Polarization in a Sequential System 

 

The default polarization state of rays is defined in the General dialog box’s Polarization section: 
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If an Analysis feature uses polarization, but its Settings do not allow for the definition of the 

polarization, then that calculation will use the settings here. However, many Analysis windows do 

allow the direct definition of the polarization state. These are the ones in the special ‘Polarization 

and Surface Physics’ group: 
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These windows default to the setting in the System Explorer, but allow direct modification. For 

example, the Polarization Ray Trace lets you can define the ray coordinates and polarization state 

directly: 
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Defining Polarization in a Non-Sequential 
System 

 

Non-Sequential source objects can have their polarization state defined in the Property Inspector 

Sources section: 

 

 
Every source can have separate polarization properties specified for it. 

 

 

 

Tutorial 9.2: Thin-Film Coatings 

 

OpticStudio has an extensive thin film modeling capability to support the polarization analysis. 

Multilayer film dielectric and metallic coatings may be defined, from either a predefined or user 

defined material database. Many thin-film codes, like The Essential Macleod, TFCalc and Film-Star, 

export coating designs directly in OpticStudio format.  
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Coatings may be applied to either dielectric or metallic substrates. Coatings may be composed of 

arbitrary layers of arbitrary material, each defined with a complex index of refraction, with full 

dispersion modeling in the coating materials. Substrates may be glass, metallic, or user defined. 

Coating layers may be of uniform or varying thickness, and loops of replicated coating stacks can be 

easily created.  

 

OpticStudio automatically reverses the coating layer order if surfaces go from air to glass then glass 

to air, so the same coating may be applied on many surfaces without the need to define “mirror 

image” coatings.  

 

Coatings are defined in a file with the .dat extension. This file is located in the coatings folder, which 

by default is My Documents\Zemax\Coatings. This folder can be modified by clicking on Project 

Preferences in the Setup tab. OpticStudio is shipped with a file called coating.dat, which contains 

sample data.  

 

Note: You should not edit coatings.dat, as it is provided by the OpticStudio installer and will be 

overwritten when you next install an update.  

 

Always place your own coating data in your own .dat file, and load it via the System Explorer Files 

section: 

 

 
  

With the coating data in place, OpticStudio computes the diattenuation, phase, retardance, 

reflection, transmission, or absorption of any coating as a function of wavelength or angle.  

 



 

Zemax, LLC Getting Started With OpticStudio 15 Tutorials    156 

Adding Coatings to Sequential Surfaces 

 

Open the sample file Sequential\Objectives\Double Gauss 28 degree field.zmx again. This uses the 

supplied coatings.dat file.  Note the Coatings column in the Lens Data Editor: 

 

 
 

Now go to the Libraries tab, and select the Coating Catalog icon from  

 

 
Scroll down to find the coating AR: 
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Coating thickness is given in units of waves at the primary wavelength unless the “Absolute” flag is 

non-zero; in which case the coating thickness is in µm independent of wavelength. The coating AR 

is, therefore, a λ/4 thick layer of the material MGF2, which is defined earlier in the coating.dat file: 

 

 
This listing gives the complex refractive index, defined as η = n + ik, where n is the usual index of 

refraction, and k is the extinction coefficient. As the material MGF2 is defined as having positive n 

and zero k, it is a pure dielectric. The material ALUM however: 
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has index <1 and negative extinction, and so is a metal (the OpticStudio convention is that 

extinction is negative for an absorbing medium). Coatings can be made up of any number of 

dielectric and metallic layers, the layer thickness can be constant or tapered, and repetitive loops of 

coatings can be easily defined. 

 

If you do not have the coating prescription, OpticStudio supports several IDEAL coatings which 

allow you to just specify reflection and transmission, and also TABLE coatings that are similar to 

IDEAL coatings, except the transmission and reflection may be a function of incident angle and 

wavelength and may be specified separately for S and P polarizations. 

 

Note: See the Polarization section of the Technical Reference for full details of the coating file syntax.  

 

Now click on Coatings…Reflection vs Angle in the Analyze tab to see the performance of this 

coating on an SK2 substrate: 
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Other plots in the same menu let you see transmission, diattenuation, phase, retardance, etc. In the 

coating column of surface 1, press the spacebar to delete the coating, and note how the reflection 

vs. angle plot changes.  

 

Coating names can be typed directly into the coating column to apply the coating to the surface, 

and the Apply Coating to All Surfaces tool in the Lens Data Editor toolbar lets you quickly add a 

coating to all surfaces of the system. 
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Adding Coatings to Non-Sequential Objects 

 

It is only a little more complex to add coatings to non-sequential objects. Because objects are 

volumes and not surfaces, one object may have several faces that can take different coatings. Open 

the sample file Non-sequential\Ray splitting\Beam Splitter.zmx to demonstrate this: 

 

 
  

Double-click on the second prism object, object 3, to open the Property Inspector and go to the 

Coat/Scatter tab. This object has two faces: face 1 which is the splitter face (the hypotenuse of the 

prism) and face 0 is everything else. 
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Face 1 is coated with an IDEAL coating I.5, which transmits 50% and reflects 50% of the ray energy, 

and face 0 is coated with I.95 which transmits 95% and reflects 5% of energy. 

  

All native OpticStudio objects use faces to define the various regions of optical interest in the object, 

and these are documented in the object definition section of the manual. Alternatively, you can use 

the NSC Object Viewer in the Analyze tab to view individual objects.  

 

 
 

If you click on a face of the object with the mouse, that face will highlight and will be identified in 

the title bar of the window: 
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Defining the Faces of CAD objects 

 

OpticStudio uses the several different CAD objects to load STL, STEP, IGES and SAT format files, and 

also to work dynamically with SolidWorks™, AutoDesk Inventor™ and Creo Parametric™ (formerly 

Pro/Engineer) parts and assemblies. These are defined by a potentially huge number of NURBS 

surfaces. Some CAD programs create data files that have many more small surfaces than is useful 

for optical analysis.  

 

For example, a simple cylinder may be described in the CAD file by hundreds of small surfaces, while 

for optical analysis only two or three different optical properties are applied to the entire object. 

Rather than assign optical properties to each of the many surfaces, it is usually more convenient to 

group CAD surfaces by assigning a single face number to all surfaces that form a continuous 

smooth portion of the object. 
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CAD objects support a ‘Face Mode’ parameter to simplify the allocation of optical faces to an 

arbitrary CAD part, as follows: 

  

 Face Mode = 0: All surfaces are assigned face number 0. The entire object will have just one 

face. This is ideal if a single optical finish, like anodized aluminum, will be applied to the 

whole object 

 

 Face Mode = 1: All surfaces whose edges meet along a non-zero length curve, and whose 

normal vectors along the curve of contact are parallel within a user defined angle tolerance 

are assigned a common face number. The angle tolerance is defined by the Face Angle 

(parameter 8). This mode allows control over how finely the faces are numbered. If the Face 

Angle is set to a large value (such as 180) then all faces that touch will share a common 

number. Larger Face Angles yield fewer unique faces. This is useful with faces that are at say 

90° have different optical properties. 

 

 Face Mode = 2: All surfaces are uniquely numbered. This mode yields the largest number of 

unique faces.  

 

 Face Mode = 3: Retains the face numbers defined in the imported file. Some CAD files, such 

as those created by Zemax, have face numbers already defined. If Zemax recognizes the face 

numbers, they will be used. If Zemax does not detect the face numbers, the surfaces will be 

numbered as for Face Mode = 2. 

 

 Face Mode = 4: All surfaces on each separate object defined in the CAD file are assigned a 

common face number. This option is useful for applying one property to all surfaces on each 

object when more than one object is defined with a single CAD file. 

 

OpticStudio also supports manual assignment of face numbers to imported object surfaces using 

the “CAD” section of the Object Properties. 

 

 

 

Tutorial 9.3: Ray Splitting 

 

Either sequential or non-sequential ray-tracing may be done while accounting for polarization 

effects, or polarization may be ignored. If polarization ray-tracing is being used, transmission, 

reflection, and absorption of optical energy is accounted for at all surfaces, and bulk absorption by 

the optical media is also accounted for. 
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In pure non-sequential ray-tracing, rays may also be split at interfaces. In this case, reflection losses 

are not just accounted for, but a new ray is launched that takes the reflected energy away. 

 

Because accurate reflection and transmission computation requires polarization information, ray 

splitting is only allowed when performing polarization ray-tracing. 

 

 
 

Ray splitting can be turned off, and in this case the transmitted path is always taken at a refractive 

interface unless the ray totally internally reflects. The reflected path is of course always taken if the 

object is a mirror. 

 

The layout above shows some of the ray paths possible in the beamsplitter example when rays are 

split. There is only 1 input ray drawn! The ray termination criteria defined in the System Explorer’s 

Non-Sequential section are essential for efficient calculation when ray splitting is on. It is advisable 
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to set the relative ray transmission reasonably high, around 0.001, until the model is working well 

and more detailed results are needed. 

 

 
 

 

OpticStudio also supports an option to randomly choose either the reflected or the refracted path 

rather than split the ray into two and trace both. This is controlled by the ‘Simple Ray Splitting’  

shown above. The decision to trace the reflected or the refracted ray is random; with the reflection 

and transmission coefficients being interpreted as a relative probability of taking that path. 
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Tutorial 9.4: Ray Scattering 

 

In addition to partial reflections at the surfaces of optical components, rays can also scatter due to 

microscopic roughness of the surface. OpticStudio supports many detailed models of scattering 

from optical surfaces, including Lambertian (used for very rough, highly scattering surfaces), 

Gaussian (typically used for modeling the scattering of a well-polished surface, ABg, K-correlation 

and more. In addition, OpticStudio can import scattering data in a simple ASCII file format, and the 

Premium edition contains a library of measured scatter profiles. See the Scattering group in the 

Libraries tab for details 

 

  
Although scattering can be used in sequential ray-tracing (see the Scattering tab Properties 

Inspector dialog), it is most useful in non-sequential ray-tracing, where rays can go wherever they 

want to. Scattering functions are applied to the faces of non-sequential objects in the same way as 

thin-film coatings are: on the Coat/Scatter tab of the Object Properties tab. 

 

Open the sample file in Non-sequential\Scattering called ABg scattering surface.zmx. This file uses 

the ABg scattering model on Object 2, which is commonly used with measured scattering data: 

 

 
  

As it is based on measured data, the total amount of energy scattered by the surface is defined by 

the data file. Other scattering models, like the Lambertian model, require you to tell OpticStudio 
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how much energy to scatter using the “Scatter Fraction” parameter on this dialog, which will appear 

if a scattering mode that requires it is chosen: 

 

 
 

If ray splitting is turned off, the ray will either scatter or not, depending on the value of the ‘Scatter 

Fraction’ parameter (or equivalent measured data) and a random number OpticStudio generates for 

each ray-object intersection. Update the NSC 3D layout, and note that the ray either scatters or does 

not scatter: 

  

 
 

 

On the Settings dialog, select “Split Rays’ as well as “Scatter Rays”: 
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The ray will now be split into the unscattered ray, and five scattered rays. 

  

Update this layout a few times, and note that you always get the unscattered ray, and five randomly 

scattered rays. The number of scattered rays is defined by the ‘Number of Rays’ parameter in the 

Coat/Scatter tab of the Object properties. 
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Tutorial 9.5: Importance Sampling 

 

A very large number of rays may need to be traced to find a relatively small number of scattered 

rays that strike an object of interest, such as a detector. OpticStudio supports two powerful ways to 

improve the efficiency of the scattering analysis. 

 

The first method is to scatter a ray according to the scatter distribution, but only trace the ray if the 

ray propagates towards an object of interest. This method may be implemented by defining a 

'Scatter To' list of objects using the 'Scatter To' tab in the Property Inspector.  

 

 
 

The Scatter To method works well for wide angle scatter (such as Lambertian scatter) and when the 

object of interest subtends a relatively large angle as seen from the scattering surface. 

 

The second method is to always scatter the ray towards the object(s) of interest, and then to 

normalize the energy the ray carries to account for the probability the ray would have actually 

scattered in that direction. This method is called "Importance Sampling". Importance Sampling is 

generally superior to the Scatter To method if the scatter is narrow angle or the object of interest 

subtends a relatively small angle as seen from the scattering surface.  

 

Open the sample file in Non-sequential\Scattering called Importance Sampling Demonstration.zmx. 

This shows directly the benefit of using Importance Sampling. Rays are always scattered to the 

desired object, in this case a detector, and the resulting signal/noise ratio is therefore far superior. 
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Tutorial 9.6: Bulk and Fluorescent 
Scattering 

 

Bulk scattering models the random scattering of rays while propagating through a solid object. This 

may be a very rare event (like scattering from inclusions in optical-quality glass) or a very common 

event (like scattering in biological tissue samples). OpticStudio includes several bulk scattering 

models, including Henyey-Greenstein and Rayleigh scattering.  

 

In addition, rays may change wavelength when bulk scattered, usually to longer wavelengths. Open 

the sample file in Non-sequential\Scattering called Fluorescence Example.zmx. This file uses two 

wavelengths, 1 (blue) and 2 (red). The source radiates only in the blue, and this light enters a 
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medium that scatters the light in angle and wavelength. A beamsplitter transmits the red and 

reflects the blue: 

 

 
 

Bulk scattering properties are defined on the ‘Bulk Scatter’ tab of the Property Inspector dialog: 

 

 
  

The “Wavelength Shift” control allows definition of wavelength transitions during bulk scatter 

events. The syntax is "in, out, prob" where "in" is the input wavelength number, "out" is the output 
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wavelength number, "prob" is the relative probability that this shift will occur when tracing the in 

wavelength. Multiple transitions may be defined using a semi colon separator. 

 

For example, if a single input wavelength (#1) will shift to wavelength #2 50% of the time, 

wavelength #3 40% of the time, and the remaining 10% of the time will remain at the input 

wavelength, then the wavelength shift string is 

 
1, 2, 50.0; 1, 3, 40.0; 1, 1, 10.0 

 

What’s Next? 

Well done on working through this guide! This guide is by necessity brief, and has only scratched 

the surface of what you can achieve with OpticStudio.  

 

The goal was to get you started using OpticStudio in just an hour or two. There is plenty that is not 

covered. For example, it does not discuss Tolerancing, Physical Optics, thermal analysis, multi-beam 

interference in non-sequential mode, and many of the powerful analysis and optimization 

capabilities of OpticStudio.  

 

Note: Just because it is not covered here does not mean that it’s not in OpticStudio! 

 

Here are some other resources that will help you: 

 

 The OpticStudio Knowledge Base. This is an indispensable resource for OpticStudio users, 

and contains hundreds of articles including tutorials, answers to frequently-asked questions, 

and examples. It is structured into categories, and has a powerful search engine to help you 

find articles of interest easily. 
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 The Technical Reference files in the Help system give detailed discussions of the underlying 

capabilities of OpticStudio 

 
 The In-Line Help files are accessed by clicking the Help “?” button in dialog boxes, and give 

detailed descriptions of the different analysis features. 

 
 Zemax LLC and its team of international distributors offer dedicated training classes on the 

use of OpticStudio. Courses are held from introductory to advanced level, and cover all 

aspects of sequential lens design, illumination, stray light, programming OpticStudio and 

more. See www.zemax.com/training for more details. 
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Getting Technical Support 

 

Please contact support@zemax.com, or your local distributor, if you need help in using OpticStudio! 

For help in the Chinese language, use china@zemax.com.  

 

Note: It is vastly easier to resolve a technical problem with a sample file that demonstrates it. Of 

course, many customers are concerned about the confidentiality of their designs. We do not undertake 

any product development contract work. Therefore, if you have a technical question, you can be sure 

that you are not explaining your work to someone who may be working for a competitor, or bidding 

against you for the same job! Our goal is simply to help you use OpticStudio most effectively. 

 

If you are still uncomfortable about sharing your design file, try simplifying it to the bare essentials 

necessary to show the problem, or use one of the >100 sample files supplied with OpticStudio 

instead.  

 

Then please follow these steps:  

 Make sure you are running the current version. Check For Updates in the Help tab. If you are 

eligible for technical support then you are eligible to run the current version. Make sure you 

can reproduce your problem with the current version as it contains fixes for all known bugs.  

 Run System Check in the Setup tab to test your file for common setup errors. 

 Email a full description of the problem to support@zemax.com or your local distributor. 

Please be sure you include:  

o Your name, organization, email address and phone number in case we need to talk 

directly with you. 

o The serial number of your OpticStudio key (run Help...About in OpticStudio to get 

this).  

o A clear description of your problem. Include the sample file that demonstrates the 

issue if you can. 

o Use File…Backup to Archive and send the resulting .ZAR file. This single file contains 

everything we need to reproduce your design exactly as you have it on your 

computer. 

 

You will get a response within a maximum of one working day, and usually a lot sooner. 

 

If support for your key is not current, you can renew it easily by sending an email to 

sales@zemax.com or your local distributor and requesting a quotation for support renewal. 
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References on Lens Design 

 

Neither the Zemax program nor the Zemax documentation will teach you how to design lenses or 

optical systems. Although the program will do many things to assist you in designing and analyzing 

optical systems, you are still the designer. The Zemax documentation is not a tutorial on optical 

design, terminology, or methodology. Technical support available to Zemax users includes 

assistance in using the program, but does not include tutoring on fundamental optical design 

principles. If you have little or no experience in optical design, you may want to read up on any of 

the many good books available on the subject. The following table lists some (but by no means all) 

of the books which will aid in your education. 

 

REFERENCES  

 

Author Title Publisher 

Bass Handbook of Optics McGraw-Hill 

Born & Wolf Principles of Optics Pergamon Press 

Fischer & Tadic-Galeb Optical System Design McGraw-Hill 

Geary, Joseph M. Introduction to  Lens  Design:  With Practical 
Zemax Examples 

Willmann-Bell 

Hecht Optics Addison Wesley 

Kingslake, Rudolph Lens Design Fundamentals Academic Press 

Laikin, Milton Lens Design, Third Edition Marcel Dekker 

Mahajan, Virendra Aberration Theory Made Simple SPIE Optical Engineering Press 

O' Shea, Donald Elements of Modern Optical Design John Wiley and Sons 

Rutten and van Venrooij Telescope Optics Willmann-Bell 

Shannon, Robert The Art and Science of OpticalDesign Cambridge University Press 

Smith, Gregory Hallock Practical Computer-Aided Lens Design 

Design 

Willmann-Bell, Inc. 

Smith, Warren Modern Optical Engineering McGraw-Hill 

Smith, Warren Modern Lens Design McGraw-Hill 

Welford Aberrations of Optical Systems Adam Hilger Ltd. 

Welford Useful Optics University of Chicago Press 
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Most importantly, Zemax is not a substitute for good engineering practices. No design should ever 

be considered finished until a qualified engineer has checked the calculations performed by the 

software to see if the results are reasonable. This is particularly important when a design is to be 

fabricated and significant costs are involved. It is the engineers responsibility to check the results of 

Zemax, not the other way around. 

 

Converting from Zemax13 and 
Older 

 

This section of the Getting Started Using Zemax OpticStudio guide is aimed at those users 

upgrading from earlier versions of Zemax (Zemax 13 and earlier). In this section we map the user 

interface of the previous versions of Zemax to their current locations, and highlight any changes of 

significance. 

 

We also recommend you read the Navigating the OpticStudio Interface section for full instructions 

on how to use the new UI. 

 

 
In the following section we will look at each Z13 menu and see where its contents have now moved 

to.  

 

Note that the button bar used in Z13 is obsolete, and instead you place any feature you want 

directly onto the Quick-Access toolbar in OpticStudio: 
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In the Setup tab, click on the Project Preferences icon and simply drag and drop the features you 

want onto the Quick-Access toolbar. 

 

 

 
 

All keyboard shortcuts used by Z13 still work in OpticStudio! 
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Zemax 13 File Menu 

 

Almost all of these features have moved to the File tab in OpticStudio 

 

Except for the Program Mode and Preferences, which are now on the Setup tab: 
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Zemax 13 Editors menu 

 

The biggest change here is that the Extra Data Editor is now obsolete. Extra Data is now appended 

onto the Lens Data Editor. The Lens Data Editor in Z13 uses parameters 0 through 12. In 

OpticStudio, extra data now appears from Parameter 13 onwards, and ther LDE simply scales in size 

to accommodate however much data you need. 

All Z13 and older files are read and remapped automatically by OpticStudio. Tolerance operands, 

multiconfiguration operands and optimization operands that referred to Extra Data parameter 

numbers are now remapped to use parameter data operands instead. As a result, .zmx files produced 

by OpticStudio can not be read successfully by older versions if the file contains extra data operands in 

the merit, multi-configuration or tolerance editors. 

In Extensions and ZPL macros you can address (previously) Extra Data items using either extra data 

operands or parameter operands with the parameter number >12. 
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Editors can be found in the Setup tab in the Editors group, which shows the two main editors and 

can expand to show all editors: 

 

The Multi-Configuration Editor is also available from the Configuration group of the Setup tab: 

 

If more than one configuration exists in the MC editor, a smaller Configuration group appears on 

the Analyze, Optimize and Tolerance tabs also: 

 

The Merit Function Editor is also available in the Optimize tab, and the Default Merit Function tool is 

renamed the Optimization Wizard: 
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The Tolerance Data Editor is also available in the Tolerance tab, and the Default Tolerances tool is 

now called the Tolerance Wizard: 

 

 
The Editors have been completely re-written to provide a modern, intuitive spreadsheet capability. 

See the Navigation guide for full details. 

Zemax 13 System Tab 
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Update and Update All are moved to the Quick-Access toolbar: 

 

 

 

The General, Fields and Wavelengths menu items are now combined in the System Explorer, which 

is available via the sidebar or the System Explorer icon in the Setup tab: 
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Filed and Wavelength data can be entered directly in the System Editor, or their older-style dialogs 

can be invoked by double-clicking on the top lines of either the Fields or Wavelengths group: 
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The Next and Last Configuration controls are on the Configuration group of the Setup tab, and if 

the design has more than one configuration are also available on the Analyze, Optimize and 

Tolerance tabs. 
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Zemax 13 Analysis Menu 

 

Almost everything on this menu has moved to the Analyze tab: 

 

With the following exceptions: 

 Glass and Gradient Index now appears in the Optical materials group of the Libraries tab 
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 Source Viewers have moved to the Source Viewers group in the Libraries tab 

 

 

 Scatter Viewers have moved to the Scatter Viewers group in the Libraries tab: 

 

 

 The items under Miscellaneous have been placed in more meaningful locations: 
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 The items under Obsolete have been removed, except for 

 

 
 

which now appear in the Export group of the File tab: 
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 Encircled Energy is now called Enclosed Energy as circles are not the only option   
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Zemax 13 Tools Menu 

 

This entire menu is now obsolete, and items have either been moved to their own tabs or to the 

toolbars of the appropriate editor. 

Tools…Design is now the Optimize tab 
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And the Zemax Part Designer is now a built-in capability with its own tab, which is available only in 

non-sequential mode, or if you have the Premium version of OpticStudio: 

 

 

Tools…Modify has moved to the toolbar of the Lens Data Editor: 
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Tools…Tolerancing has become the Tolerance tab: 

 

 

 

Tools…Catalogs has become the Libraries tab: 
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Tools…Export/Explode has moved to the Export and Explode groups on the File tab 

 



 

Zemax, LLC Getting Started With OpticStudio 15 Converting from Zemax13 and Older    194 

 

 

 

Tools…Sources has moved to the Sources group on the Libraries tab: 
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Tools…Scatter has moved to the Scatter group of the Libraries tab 

 

 

Tools…Miscellaneous is obsolete and its features have been placed in more meaningful locations: 
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The Ghost Focus Generator is now on the Analyze tab, in the Applications Group  

 

 

The Performance Test and Test Network Server are now in the Diagnostics group of the Setup tab: 
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The file conversion and MatLab® export tools are now on the File tab Convert group: 
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Zemax 13 Reports Menu 

 

These are now in the Reports group on the Analyze tab: 
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Note that the Report Graphic 4 and Report Graphic 6 have no equivalent in OpticStudio. These 

features were only supported by the Z13 graphics engine. A replacement feature will be 

incorporated in a future release. 

Zemax 13 Macros Menu 

 

This is now in the ZPL Macros group of the Programming tab 

 

A built-in macro editor is now provided. 
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Zemax 13 Extensions Menu 

 

 

This is now in the Extensions group of the Programming tab 
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Zemax 13 Help Menu 

 

Now on the Help tab 

 

 

The Help system is now a searchable hyperlinked document, organized by the tabs in the main 

ribbon bar of the OpticStudio UI. 
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2D Analysis Windows 

 

The Settings dialog may now be left open and changes may be auto-applied. Right-mouse-clicking 

now brings up a context menu. Data markers may be set on most windows, and the interactivity of 

all windows is greatly improved. Data is no longer recalculated when displayed differently: data is 

only recalculated if the calculation settings change. 

 

There is a wider range of options available via right-mouse-click, and a toolbar provides access to all 

tools associated with the window. The scale of the axes can be changed by selecting the sliders on 

each end of the axes. See the full discussion of Analysis windows in the Navigation section. 
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3D Analysis Windows 

 

All the benefits of the 2D Analysis windows, plus the 3D projection can be rotated by holding down 

the left mouse button and dragging, zoomed by holding down the scroll wheel and panned by 

holding down the right mouse button. Again, see the full discussion of Analysis windows in the 

Navigation section. 

 

Shaded Model 

 

This has been completely re-written to provide a CAD-like user experience. See the full discussion in 

the Navigation section. 

 

Editors 

 

The editors have been completely re-written to make them more intuitive spreadsheets. Each editor 

how has a toolbar with all its associated tools on it. For more information, see the “Using the 

Editors” section of the Help Files under The Setup Tab > Editors Group.  

Conventions and Definitions 

This chapter describes the conventions and defines terminology used throughout this manual. Most 

of the conventions and terms Zemax uses are common in the optics industry, however there may be 

some important differences. 
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Active configuration 

The active configuration is the configuration currently being displayed in the lens data editor. For 

details see the Help Files chapter about the Multiple Configuration Editor. 

Angular magnification 

The ratio of the paraxial image space chief ray angle to the paraxial object space chief ray angle. The 

angles are measured with respect to the paraxial entrance and exit pupil locations. 

Apodization 

Apodization refers to the uniformity of illumination in the entrance pupil of the system. By default, 

the pupil is always illuminated uniformly. However, there are times when the pupil should have a 

non-uniform illumination. For this purpose, Zemax supports pupil apodization, which is a variation 

of amplitude over the pupil. 

Three types of pupil apodization are supported: uniform, Gaussian, and tangential. For each type 

(except uniform), an apodization factor determines the rate of variation of amplitude in the pupil. 

See the discussion on apodization types and factors in the Aperture section of the Help Files chapter 

about the System Explorer. 

Zemax also supports user defined apodizations, which may be placed on any surface. Surface 

apodizations behave differently than pupil apodizations, because surfaces need not be located at a 

pupil. For more information on surface apodizations, see the Help Files chapter about the Lens Data 

Editor and the User Defined surface. 

Back focal length 

Zemax defines the back focal length as the distance along the Z axis from the last surface made of 

glass to the paraxial image surface for the object at infinite conjugates. If no surfaces are made of 

glass, the back focal length is the distance from surface 1 to the paraxial image surface for the 

object at infinite conjugates. 

Cardinal planes 

The term cardinal planes (sometimes called cardinal points) refers to those special conjugate 

positions where the object and image surfaces have a specific magnification. The cardinal planes 

include the principal planes, where the lateral magnification is +1, the anti-principal planes, where 

the lateral magnification is -1, the nodal planes, where the angular magnification is +1, the anti-

nodal planes, where the angular magnification is -1, and the focal planes, where the magnification is 

0 for the image space focal plane and infinite for the object space focal plane. 

Except for the focal planes, the cardinal planes are conjugates with each other, that is, the image 

space principal plane is conjugate with the object space principal plane, etc. If the lens has the same 

index in both object space and image space, the nodal planes are identical to the principal planes. 
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Zemax lists the distance from the image surface to the various image space planes, and lists the 

distance from the first surface to the various object space planes. 

Chief ray 

If there is no vignetting, and there are no aberrations, the chief ray is defined to be the ray that 

travels from a specific field point, through the center of the entrance pupil, and on to the image 

surface. Note that without vignetting or aberrations, any ray passing through the center of the 

entrance pupil will also pass through the center of the stop and the exit pupil. 

When vignetting factors are used, the chief ray is then considered to be the ray that passes through 

the center of the vignetted pupil, which means the chief ray may not necessarily pass through the 

center of the stop. 

If there are pupil aberrations, and there virtually always are, then the chief ray may pass through the 

center of the paraxial entrance pupil (if ray aiming is off) or the center of the stop (if ray aiming is 

on), but generally, not both. 

If there are vignetting factors which decenter the pupil, then the chief ray will pass through the 

center of the vignetted entrance pupil (if ray aiming is off) or the vignetted stop surface (if ray 

aiming is on). 

The common convention used is that the chief ray passes through the center of the vignetted pupil, 

while the principal ray passes through the center of the unvignetted stop. Zemax never uses the 

principal ray. Most calculations are referenced to the chief ray or the centroid. Note the centroid 

reference is generally superior because it is based upon the aggregate effect of all the rays that 

actually illuminate the image surface, and not on the arbitrary selection of one ray which is “special”. 

Coordinate axes 

The optical axis is the Z axis, with the initial direction of propagation from the object being the 

positive Z direction. Mirrors can subsequently reverse the direction of propagation. The coordinate 

system is right handed, with the sagittal X axis being oriented "into" the monitor on a standard 

layout diagram. The tangential Y axis is vertical. 

The direction of propagation is initially left-to-right, down the positive Z axis. After an odd number 

of mirrors the beam physically propagates in a negative Z direction. Therefore, all thicknesses after 

an odd number of mirrors should be negative. 

Diffraction limited 

The term diffraction limited implies that the performance of an optical system is limited by the 

physical effects of diffraction rather than imperfections in either the design or fabrication. A 

common means of determining if a system is diffraction limited is to compute or measure the 

optical path difference. If the peak to valley OPD is less than one quarter wave, then the system is 

said to be diffraction limited. 
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There are many other ways of determining if a system is diffraction limited, such as Strehl ratio, RMS 

OPD, standard deviation, maximum slope error, and others. It is possible for a system to be 

considered diffraction limited by one method and not diffraction limited by another method. 

On some Zemax plots, such as the MTF or Diffraction Encircled Energy, the diffraction limited 

response is optionally shown. This data is usually computed by tracing rays from a reference point in 

the field of view. Pupil apodization, vignetting, F/#’s, surface apertures, and transmission may be 

accounted for, but the optical path difference is set to zero regardless of the actual (aberrated) 

optical path. 

For systems which include a field point at 0.0 in both x and y field specifications (such as 0.0 x angle 

and 0.0 y angle), the reference field position is this axial field point. If no (0, 0) field point is defined, 

then the field coordinates of field position 1 are used as the reference coordinates instead. 

 

Edge thickness 

Zemax defines the edge thickness of a surface as: 

 

where is the sag of the surface, is the sag of the next surface, and  is the axial thickness of the 

surface. The sag values are computed at the +y semi-diameter of their respective surfaces; Note that 

edge thickness is computed for the +y radial aperture, which may be inadequate if the surface is not 

rotationally symmetric, or if surface apertures have been placed upon either of the surfaces. 

Edge thickness solves use a slightly different definition of edge thickness. For edge thickness solves 

only, the sag of the i+1 surface is computed at the semi-diameter of surface i. This method avoids a 

possible infinite loop in the calculation, since changing the thickness of surface i may alter the semi-

diameter of surface i+1, if the latter semi-diameter is in “automatic” mode and the value is based 

upon ray tracing. See “Thickness: Edge thickness” and “Entering semi-diameter data” for more 

information. 

Effective focal length 

The distance from the rear principal plane to the paraxial image surface. This is calculated for infinite 

conjugates. Principal plane calculations are always based upon paraxial ray data. The effective focal 

length is always referenced to an index of refraction of 1.0, even if the image space index is not 

unity. 

Entrance pupil diameter 

The diameter in lens units of the paraxial image of the stop in object space. 

Entrance pupil position 

The paraxial position of the entrance pupil with respect to the first surface in the system. The first 

surface is always surface 1, not the object surface, which is surface 0. 
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Exit pupil diameter 

The diameter in lens units of the paraxial image of the stop in image space. 

Exit pupil position 

The paraxial position of the exit pupil with respect to the image surface. 

Field angles and heights 

Field points may be specified as angles, object heights (for systems with finite conjugates), paraxial 

image heights, or real image heights. Field angles are always in degrees. The angles are measured 

with respect to the object space z axis and the paraxial entrance pupil position on the object space z 

axis. Positive field angles imply positive slope for the ray in that direction, and thus refer to negative 

coordinates on distant objects. Zemax converts x field angles (αx) and y field angles (αy) to ray 

direction cosines using the following formulas: 

 

where l, m, and n are the x, y, and z direction cosines. 

If object or image heights are used to define the field points, the heights are measured in lens units. 

When paraxial image heights are used as the field definition, the heights are the paraxial image 

coordinates of the primary wavelength chief ray on the paraxial image surface, and if the optical 

system has distortion, then the real chief rays will be at different locations. When real image heights 

are used as the field definition, the heights are the real ray coordinates of the primary wavelength 

chief ray on the image surface. 

Zemax uses normalized field coordinates for many features. For information on how field 

coordinates are normalized, see the “Normalized field coordinates” definition. To set the field type 

and values, see Help Files chapter about the Setup Tab > System Explorer > Fields. 

Float by stop size 

Float by stop size is one of the system aperture types supported by Zemax. This phrase refers to the 

fact that the entrance pupil position, object space numerical aperture, image space F/#, and stop 

surface radius all are specified if just one of them is specified. Therefore, setting the stop radius, and 

then allowing the other values to be whatever they are, is a perfectly valid way of defining the 

system aperture. It is particularly handy when the stop surface is a real, unchangeable aperture 

buried in the system, such as when designing null corrector optics. 
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Ghost reflections 

Ghost reflections are spurious, unwanted images formed by the small amount of light which reflects 

off of, rather than refracts through a lens face. For example, the multiple images of the aperture 

stop visible in photographs taken with the sun in the field of view are caused by ghost reflections. 

Ghost images can be problematic in imaging systems and in high power laser systems. 

Glasses 

Glasses are entered by name in the glass column. Available glasses may be reviewed, and new ones 

entered using the glass catalog tool. See the Chapter "Using Glass Catalogs" for details. 

Blanks are treated as air, with unity index. Mirrors can be specified by entering "MIRROR" for the 

glass type, although this name will not appear in the glass catalog. The index of refraction of the 

mirror space is always equal to the index of refraction of the media before the mirror. 

For information on the effect of temperature and pressure on index of refraction data, search the 

Help Files for “Defining temperature and pressure”.  

Hexapolar rings 

Zemax usually selects a ray pattern for you when performing common calculations such as spot 

diagrams. The ray pattern refers to how a set of rays is arranged on the entrance pupil. The 

hexapolar pattern is a rotationally symmetric means of distributing a set of rays. The hexapolar 

pattern is described by the number of rings of rays around the central ray. The first ring contains 6 

rays, oriented every 60 degrees around the entrance pupil with the first ray starting at 0 degrees (on 

the x-axis of the pupil). The second ring has 12 rays (for a total of 19, including the center ray in ring 

“0”). The third ring has 18 rays. Each subsequent ring has 6 more rays than the previous ring. 

Many features which require a sampling parameter to be specified (such as the spot diagram) use 

the number of hexapolar rings as a convenient means of specifying the number of rays. If the 

hexapolar sampling density is 5, it does not mean that 5 rays will be used. A sampling of 5 means 1 

+ 6 + 12 + 18 + 24 + 30 = 91 rays will be used. 

Image space F/# 

Image space F/# is the ratio of the paraxial effective focal length calculated at infinite conjugates 

over the paraxial entrance pupil diameter. Note that infinite conjugates are used to define this 

quantity even if the lens is not used at infinite conjugates. 

Image space numerical aperture (NA) 

Image space NA is the index of image space times the sine of the angle between the paraxial on-

axis chief ray and the paraxial on-axis +y marginal ray calculated at the defined conjugates for the 

primary wavelength. 
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Lens units 

Lens units are the primary unit of measure for the lens system. Lens units apply to radii, thicknesses, 

apertures, and other quantities, and may be millimeters, centimeters, inches, or meters. 

Marginal ray 

The marginal ray is the ray that travels from the center of the object, to the edge of the entrance 

pupil, and on to the image surface. 

If there is vignetting, Zemax extends this definition by defining the marginal ray to be at the edge of 

the vignetted entrance pupil. If ray aiming is on, then the marginal ray is at the edge of the 

vignetted stop.  

See also the definition of the chief ray. 

Maximum field 

The maximum field is the minimum radial coordinate that would enclose all the defined field points 

if the x and y values of each field point were plotted on an Cartesian XY plot. The maximum field is 

measured in degrees if the field type is angles, or in lens units for object height, paraxial image 

height, or real image height. To set the field type and values, go to the Setup Tab > System Explorer 

> Fields.  For more information on the field type, search the Help Files for “Field angles and 

heights”.  

Non-paraxial systems 

The term non-paraxial system refers to any optical system which cannot be adequately represented 

by paraxial ray data. This generally includes any system with tilts or decenters, strong aspheres, 

axicons, holograms, gratings, cubic splines, ABCD matrices, gradient index, diffractive components, 

or non-sequential surfaces. 

A great deal of optical aberration theory has been developed for systems with conventional 

refractive and reflective components in rotationally symmetric configurations. This includes Seidel 

aberrations, distortion, Gaussian beam data, and virtually all first order properties such as focal 

length, F/#, and pupil sizes and locations. All of these values are calculated from paraxial ray data. 

If the system being analyzed contains any of the non-paraxial components described, then any data 

computed based upon paraxial ray tracing cannot be trusted. Zemax will generally use exact real 

rays rather than paraxial rays for ray tracing through these surfaces and components. 

A system which is well described by paraxial optics will have the general property that the real and 

paraxial marginal ray data converge as the radial entrance pupil coordinate of the rays being traced 

tends toward zero. 

Non-sequential ray tracing 

Non-sequential ray tracing means rays are traced only along a physically realizable path until they 

intercept an object. The ray then refracts, reflects, or is absorbed, depending upon the properties of 
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the object struck. The ray then continues on a new path. In non-sequential ray tracing, rays may 

strike any group of objects in any order, or may strike the same object repeatedly; depending upon 

the geometry and properties of the objects. 

See also the definition of “Sequential ray tracing”.  

Normalized field coordinates 

Normalized field coordinates are used in both the Zemax program and documentation. There are 

two normalized field coordinates: Hx and Hy. Normalized field coordinates are convenient because 

useful field locations may be defined in a manner that does not change with the individual field 

definitions or field of view of the optical system. For example, the normalized field coordinate (0, 1) 

is always at the top of the field of view, whether the field points are defined as angles or heights, 

and regardless of the magnitude of the field coordinates. 

There are two methods used to normalize fields: radial and rectangular. The choice of field 

normalization method is made on the Field Data dialog; for a description see the “Field angles and 

heights” definition. 

 

Radial field normalization 

If the field normalization is radial, then the normalized field coordinates represent points on a unit 

circle. The radius of this unit circle, called the maximum radial field, is given by the radius of the field 

point farthest from the origin in field coordinates. The maximum radial field magnitude is then used 

to scale all fields to normalized field coordinates. Real field coordinates can be determined by 

multiplying the normalized coordinates,  Hx and Hy , by the maximum radial field magnitude: 

 

where Fr is the maximum radial field magnitude and fx and fy are the field coordinates in field units. 

 

For example, suppose 3 field points are defined in the (x, y) directions using object height in lens 

units at (0.0, 0.0), (10.0, 0.0), and (0.0, 3.0). The field point with the maximum radial coordinate is the 
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second field point, and the maximum radial field is therefore 10.0. The normalized coordinate (Hx = 

0, Hy = 1) would refer to the field coordinates (0.0, 10.0). The normalized coordinate (Hx = 1, Hy = 

0) would refer to the field coordinates (10.0, 0.0). Note the normalized field coordinates can define 

field coordinates that do not correspond to any defined field point. The maximum radial field is 

always a positive value. 

If a fourth field point at (-10.0, -3.0) were added in the above example, the maximum radial field 

would become 

 

or approximately 10.44031. Normalized coordinates should always be between -1 and 1, and should 

also meet the condition: 

 

Otherwise, the field point lies outside of the maximum radial field. 

 

Rectangular field normalization 

If the field normalization is rectangular, then the normalized field coordinates represent points on a 

unit rectangle. The x and y direction widths of this unit rectangle, called the maximum x field and 

maximum y field, are defined by the largest absolute magnitudes of all the x and y field coordinates. 

The maximum x and y field magnitudes are then used to scale all fields to normalized field 

coordinates. Real field coordinates can be determined by multiplying the normalized coordinates,  

Hx and Hy , by the maximum x and y field magnitudes: 

  

where Fx and Fy are the maximum x and y field magnitudes, and fx and fy are the field coordinates in 

field units. 

 

For example, suppose 3 field points are defined in the (x, y) directions using object height in lens 

units at (0.0, 0.0), (10.0, 0.0), and (0.0, 3.0). The field point with the maximum x coordinate is the 

second field point, and the maximum x field is therefore 10.0. The field point with the maximum y 

coordinate is the third field point, and the maximum y field is therefore 3.0. The normalized 

coordinate (Hx = 0, Hy = 1) would refer to the field coordinates (0.0, 3.0). The normalized coordinate 
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(Hx = 1, Hy = 0) would refer to the field point (10.0, 0.0). The normalized coordinate (Hx = 1, Hy = 1) 

would refer to the field coordinates (10.0, 3.0). Note the normalized field coordinates can define 

field coordinates that do not correspond to any defined field point. The maximum x and y field are 

always positive values. 

If a fourth field point at (-10.0, -3.0) were added in the above example, the maximum x and y field 

values would not change. Normalized rectangular coordinates should always be between -1 and 1. 

Normalized pupil coordinates 

Normalized pupil coordinates are often used in both the Zemax program and documentation. There 

are two normalized pupil coordinates: Px and Py. Normalized pupil coordinates are convenient 

because useful pupil locations may be defined in a manner that does not change with the aperture 

size or position. For example, the normalized pupil coordinate (0.0, 1.0) is always at the top of the 

pupil, and therefore defines a marginal ray. The normalized pupil coordinate (0.0, 0.0) always goes 

through the center of the pupil, and therefore defines a chief ray. 

The normalized pupil coordinates represent points on a unit circle. The radial size of the pupil is 

defined by the radius of the paraxial entrance pupil, unless ray aiming is turned on, in which case 

the radial size of the pupil is given by the radial size of the stop. For more information on ray aiming 

see the Help Files chapter called the Setup tab > System Explorer > Ray Aiming. 

For example, if the entrance pupil radius (not diameter) is 8 mm, then (Px = 0.0, Py = 1.0) refers to a 

ray which is aimed to the top of the entrance pupil. On the entrance pupil surface, the ray will have 

a coordinate of (x = 0.0 mm, y = 8.0 mm). 

Note that the normalized pupil coordinates should always be between -1 and 1, and that 

  

A significant advantage of using normalized pupil coordinates is that rays defined in normalized 

coordinates remain meaningful as the pupil size and position changes. Suppose prior to optimizing 

a lens design, a ray set is defined to compute the system merit function. By using normalized 

coordinates, the same ray set will work unaltered if the entrance pupil size or position or object size 

or position is changed later, or perhaps even during the optimization procedure. 

Object space numerical aperture 

Object space numerical aperture is a measure of the rate of divergence of rays emanating from the 

object surface. The numerical aperture is defined as the index of refraction times the sine of the 

paraxial marginal ray angle, measured in object space. The marginal ray defines the boundary of the 

cone of light diverging from an object point. 

Parameter data 

Parameter data values are used to define certain non-standard surface types. For example, 

parameter data may include aspheric coefficients, grating spacings, or tilt and decenter data. For a 



 

Zemax, LLC Getting Started With OpticStudio 15 Conventions and Definitions    213 

complete discussion of the parameter data values see the Sequential Surfaces section under Lens 

Data Editor in the Help Files. 

Paraxial and parabasal rays 

The term paraxial means "near the axis". Paraxial optics are optics that are well described by the 

linear form of Snell’s law. Snell’s law is: 

 

For small angles this becomes 

 

Many definitions in optics are based upon this assumption of linearity. Aberrations are deviations 

from this linearity, and so the paraxial properties of optical systems are often considered the 

properties the system has in the absence of aberrations. Paraxial rays are traced using formulas 

which assume the optical surface power is based only upon the vertex radius of curvature, ignoring 

local linear tilts and higher order curvature of the surface. 

Paraxial data is computed on a plane tangent to the surface vertex, assuming the vertex radius of 

curvature is an acceptable approximation to the surface power over the entire aperture of the 

surface. Certain unusual surface types do not have a paraxial analog, so the real ray tracing 

calculations are made at these surfaces, even for a paraxial ray. 

Zemax computes many paraxial entities, such as focal length, F/#, focal position, entrance pupil 

diameter, and others. These values should be used with caution when the optical system has 

components which violate the assumption that the vertex curvature is an acceptable approximation 

to the surface power over the entire aperture of the surface. 

For many analysis features, paraxial data is required, typically as a reference against which real rays 

are measured. To ensure these features work properly, even for optical systems that do not meet 

the paraxial assumption above, Zemax traces “parabasal” rays which are real (real means using 

Snell's law explicitly) that make small angles with respect to a reference ray, which is usually an axis 

or chief ray. The parabasal rays are used to compute the limiting properties of the system as the 

stop size is decreased, which provides a good estimate of the paraxial properties. 

The reason Zemax uses parabasal rays rather than paraxial formulas is because many optical 

systems include non-paraxial components. Non-paraxial means these components are not well 

described by conventional axial first-order theory. This includes tilted or decentered systems, 

systems using holograms, diffractive optics, general aspheres, and gradient index lenses. 

In summary, paraxial ray data is computed using first order approximations to the surface power for 

tracing rays, while parabasal rays are real, exact ray traces close to a chief or reference ray. Most 

paraxial data, such as EFL, F/#, and magnification, use paraxial rays and the data is invalid if the 

optical system is not well described by the vertex power of every surface. Most analysis features in 

Zemax use parabasal rays, to allow these features to work with a greater range of optical systems, 

including those with optical surfaces not well described solely by their vertex surface power. 
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Paraxial image height 

The paraxial radial size of the image in lens units of the full field image at the paraxial image surface. 

Paraxial magnification 

The radial magnification, being the ratio of paraxial image height to object height. The paraxial 

magnification is measured at the paraxial image surface. The value is always zero for infinite 

conjugate systems. 

Paraxial working F/# 

The paraxial working F/# is defined as 

 

where θ is the paraxial marginal ray angle in image space and n is the index of refraction of image 

space. The paraxial marginal ray is traced at the specified conjugates. For non-axial systems, this 

parameter is referenced to the axis ray and is averaged over the pupil. The paraxial working F/# is 

the effective F/# ignoring aberrations. See also the definition for “working F/#”. 

Primary wavelength 

The primary wavelength in micrometers is displayed. This value is used for calculating most other 

paraxial or system values, such as pupil positions. 

Radii 

The radius of curvature of each surface is measured in lens units. The convention is that a radius is 

positive if the center of curvature is to the right (a positive distance along the local z axis) from the 

surface vertex, and negative if the center of curvature is to the left (a negative distance along the 

local z axis) from the surface vertex. This is true independent of the number of mirrors in the system. 

Real propagation 

A real propagation means the rays are propagated in the direction energy would actually flow. See 

also the definitions for “Virtual propagation” and “Thicknesses”. 

Sagittal and Tangential 

The term "tangential" refers to data computed in the tangential plane, which is the plane defined by 

a line and one point: the line is the axis of symmetry, and the point is the field point in object space. 

The sagittal plane is the plane orthogonal to the tangential plane, which also intersects the axis of 

symmetry at the entrance pupil position. 
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For typical rotationally symmetric systems with field points lying along the Y axis, the tangential 

plane is the YZ plane and the sagittal plane is the plane orthogonal to the YZ plane which intersects 

the center of the entrance pupil. 

The problem with this definition is that it is not readily extended to non-rotationally symmetric 

systems. For this reason, Zemax instead defines the tangential plane to be the YZ plane regardless 

of where the field point is, and tangential data is always computed along the local y axis in object 

space. The sagittal plane is the orthogonal to the YZ plane, and intersects the center of the entrance 

pupil in the usual way, and sagittal data is always computed along the x axis in object space. 

The philosophy behind this convention is as follows. If the system is rotationally symmetric, then 

field points along the Y axis alone define the system imaging properties, and these points should be 

used. In this case, the two different definitions of the reference planes are redundant and identical. If 

the system is not rotationally symmetric, then there is no axis of symmetry, and the choice of 

reference plane is arbitrary. 

One feature, the computation of Fast Semi-Diameters (see the Advanced section of the System 

Explorer), does use the “true” tangential plane, which Zemax defines as the plane that contains the 

actual field point and the z axis in object space. 

Semi-diameters 

The size of each surface is described by the semi-diameter setting. The default setting is the radial 

distance to the aperture required to pass all real rays without clipping any of the rays. Typing a 

value for the semi-diameter column results in the character “U” being displayed next to the value. 

The “U” indicates that the semi-diameter is user defined. When a user-defined semi-diameter is 

placed on a surface with refractive power (which is done by typing in a value in the appropriate 

column), and no surface aperture has been defined, Zemax automatically applies a “floating” 

aperture to the surface. A floating aperture is a circular aperture whose radial maximum coordinate 

is always equal to the semi-diameter of the surface. For more information on surface aperture types, 

see the Aperture section of the Surface Properties (in the Lens Data Editor). 

Semi-diameters on any surface for axial symmetric systems are computed very accurately, as long as 

the surface does not lie within the caustic of the ray bundle (note this usually occurs at or near the 

image surface). Zemax estimates semi-diameters for axial systems by tracing a few marginal pupil 

rays. For non-axial systems, Zemax estimates the required semi-diameters using either a fixed 

number of rays or by an iterative technique, which is slower but more accurate. See the explanation 

of “Fast Semi-Diameters” in the Advanced section of the System Explorer for details. It is important 

to note that the “automatic” semi-diameter computed by Zemax is an estimate, although it is 

generally a very good one. 

Some surfaces may become so large in aperture that the surface z coordinate becomes multiple 

valued; for example, a very deep ellipse may have more than one z coordinate for the same x and y 

coordinates on the surface. For the case of spherical surfaces, this condition is called 

“hyperhemispheric” and Zemax uses this term even if the surface is not a sphere. Hyperhemispheric 

surfaces are denoted by an asterisk “*” in the semi-diameter column. The indicated semi-diameter is 
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of the outer edge of the surface, which will have a smaller radial aperture than the maximum radial 

aperture. 

Sequential ray tracing 

Sequential ray tracing means rays are traced from surface to surface in a predefined sequence. 

Zemax numbers surfaces sequentially, starting with zero for the object surface. The first surface after 

the object surface is 1, then 2, then 3, and so on, until the image surface is reached. Tracing rays 

sequentially means a ray will start at surface 0, then be traced to surface 1, then to surface 2, etc. No 

ray will trace from surface 5 to 3; even if the physical locations of these surfaces would make this the 

correct path. 

See also the “Non-sequential ray tracing” definition. 

Special characters 

There are many places in Zemax where user defined file, material, glass, or other names may be 

provided. Generally, Zemax allows any characters to be used in these names, except for a few 

reserved “special characters” The special characters are space, semi-colon, single quote, and tab. 

Strehl ratio 

The Strehl ratio is one commonly used measure of optical image quality for very high quality 

imaging systems. The Strehl ratio is defined as the peak intensity of the diffraction point spread 

function (PSF) divided by the peak intensity of the diffraction point spread function (PSF) in the 

absence of aberrations. Zemax computes the Strehl ratio by computing the PSF with and without 

considering aberrations, and taking the ratio of the peak intensity. The Strehl ratio is not useful 

when the aberrations are large enough to make the peak of the PSF ambiguous, or for Strehl ratios 

smaller than about 0.1. 

Surface apertures 

Surface apertures include circular, rectangular, elliptical, and spider shaped apertures which can 

vignette rays. There are also user defined shapes for surface apertures and obscurations; and a 

“floating” aperture that is based upon the current semi-diameter value. Surface apertures do not 

affect ray launching or tracing, except for the termination of a ray if it does not pass the surface 

aperture. Surface apertures have no effect on the system aperture. For more information, see the 

Aperture section of the Surface Properties 

System aperture 

The system aperture is the overall system F/#, Entrance Pupil Diameter, Numerical Aperture, or Stop 

Size. Any of these 4 quantities is sufficient to define the other 3 for a particular optical system. The 

system aperture is used to define the object space entrance pupil diameter, which in turn is used to 

launch all rays. The system aperture is always circular. Rays may be vignetted after being launched 
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by various surface apertures. There is only one system aperture, although there may be many 

surface apertures. 

Thicknesses 

Thicknesses are the relative distance to the next surface vertex in lens units. Thicknesses are not 

cumulative, each one is only the offset from the previous vertex along the local z axis. The 

orientation of the local z axis can change using coordinate breaks (see the Coordinate Break surface 

in the Lens Data Editor section of the Help Files) or surface tilts and decenters (see the Tilt/Decenter 

section of the Surface Properties). 

Thicknesses corresponding to real propagation (see “Real propagation”) always change sign after a 

mirror. After an even number of mirrors (including zero mirrors), thickness are positive for real 

propagations and negative for virtual propagations (see “Virtual propagation”). After an odd 

number of mirrors, thicknesses are negative for real propagations and positive for virtual 

propagations. This sign convention is independent of the number of mirrors, or the presence of 

coordinate breaks. This fundamental convention cannot be circumvented through the use of 

coordinate rotations of 180 degrees. 

Total internal reflection (TIR) 

TIR refers to the condition where a ray makes too large an angle with respect to the normal of a 

surface to meet the refraction condition as specified by Snell's Law. This usually occurs when a ray 

with a large angle of incidence is refracting from a high index media to a lower index media, such as 

from glass to air. When doing sequential ray tracing, rays which TIR are considered errors, and are 

terminated. Physically, the ray would reflect rather than refract from the boundary, but Zemax does 

not consider this effect when doing sequential ray tracing. For non-sequential ray tracing, rays 

which TIR are properly reflected. 

 

Total track 

Total track is the length of the optical system as measured by the vertex separations between the 

“left most” and “right most” surfaces. The computation begins at surface 1. The thickness of each 

surface between surface 1 and the image surface is considered, ignoring any coordinate rotations. 

The surface which lies at the greatest z coordinate defines the “right most” surface, while the surface 

with the minimum z coordinate defines the “left most” surface. Total track has little or no value in 

non-axial systems. 

Vignetting factors 

Vignetting factors are coefficients which describe the apparent entrance pupil size and location for 

different field positions. Zemax uses five vignetting factors: VDX, VDY, VCX, VCY, and VAN. These 

factors represent decenter x, decenter y, compression x, compression y, and angle, respectively. The 

default values of all five factors are zero, which indicates no vignetting. 
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Both the field of view and the entrance pupil of an optical system can be thought of as unit circles. 

The normalized field and pupil coordinates, defined in “Normalized field coordinates”, are the 

coordinates on these two unit circles. For example, the pupil coordinates (px = 0, py = 1) refer to the 

ray which is traced from some point in the field to the top of the entrance pupil. If there is no 

vignetting in the system, Zemax will trace rays to fill the entire entrance pupil during most 

computations. 

Many optical systems employ deliberate vignetting. This means a portion of the rays are 

intentionally "clipped" by apertures other than the stop surface. There are two common reasons for 

introducing vignetting in an optical system. First, vignetting decreases the size of the lenses, 

particularly in wide angle lenses. Second, vignetting may remove a portion of the beam which would 

be excessively aberrated. Vignetting usually increases the F/# as a function field angle (which 

darkens the image), but the image quality may improve if the most severely aberrated rays are 

clipped. 

Vignetting factors redefine the entrance pupil for a specific field position. The normalized pupil 

coordinates are modified using two successive transformations. First, the coordinates are scaled and 

shifted: 

𝑃 ′𝑥 =  𝑉𝐷𝑋 +  𝑃𝑥(1 − 𝑉𝐶𝑋), and 

𝑃 ′𝑦 =  𝑉𝐷𝑌 +  𝑃𝑦(1 − 𝑉𝐶𝑌), . 

The scaled and shifted coordinates are then rotated by the vignetting angle: 

𝑃 ′′ 𝑥 =  𝑃 ′𝑥 cos θ − 𝑃 ′𝑦 sin θ ,  and 

𝑃 ′′𝑦 =  𝑃 ′𝑥 sin θ + 𝑃 ′𝑦 cos θ , 

where θ is the vignetting angle VAN. The VDX term can shift the apparent pupil left and right, while 

VCX makes the pupil larger or smaller in the x direction. Similar results hold for the VDY and VCY 

values. Note that if the vignetting factors are all zero, the pupil coordinates are left unmodified. 

Vignetting factors provide a convenient way of designing optics which employ vignetting. However, 

there are restrictions to using vignetting factors that must be understood. 

Some Zemax features are capable of tracing rays from arbitrary field positions where no vignetting 

factors have been assigned. These features may not provide completely accurate results for data 

computed at field positions other than the defined fields. Some features will remove the vignetting 

factors for these computations by placing a clear aperture on each surface that vignettes the rays an 

equivalent amount. Features that automatically remove the vignetting factors are described in the 

Analysis chapter. 

Some features in Zemax do not automatically remove vignetting factors for intermediate field 

positions, such as ray operands in the merit function (operands like REAX that can launch a single 

ray, for example) or ZPL macros. If the vignetting factors are not removed, Zemax will attempt to 

interpolate the vignetting factors. For rotationally symmetric systems, or systems with field points 

entirely along the y axis, Zemax interpolates between adjacent field points to estimate the 

vignetting factors to use at intermediate field points. For more general optical systems with X field 

values, Zemax uses the closest defined field point for determining the vignetting factors for an 

arbitrary field point. 
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Once a vignetting factor is defined, it is up to the designer to ensure that rays beyond the apparent 

pupil are in fact vignetted! If the vignetting factor is used to shrink the size of the lenses, then the 

lenses should be made no larger than is required to pass the rays which are at the edge of the 

apparent pupil. If rays from beyond the vignetted aperture are allowed to pass in the real optical 

system, then the lens performance will not correlate with the computer model. 

Identical or nearly identical field coordinates may not be defined with different vignetting factors. 

Field coordinates must be different by roughly 1E-06 times the maximum field coordinate if two 

neighboring fields use different vignetting factors. This is required because Zemax must determine 

vignetting factors for any field coordinates, not just those at defined field positions; and identical 

field coordinates with different vignetting factors have no physical interpretation. The proper way to 

set up this sort of system is to use multiple configurations, and change the vignetting factors via the 

multi-configuration editor. 

The vignetting factors work with and without ray aiming turned on. If ray aiming is off, then the 

paraxial entrance pupil is remapped according to the equations given earlier. If ray aiming is turned 

on, then the remapping is done at the stop surface. 

One possible application of vignetting factors is to account for pupil aberration without using the 

ray aiming feature. This is an advanced trick which can be used to speed up ray tracing in wide 

angle systems. 

Vignetting factors may be defined on the “Field Data” dialog box. See the Fields section of the 

System Explorer for more information. Vignetting factors may also be zoomable parameters; see the 

Chapter “Multi-Configurations”. For more information on the use of vignetting as a design tool, see 

any of the good books referenced in the first chapter. 

Virtual propagation 

A virtual propagation means the rays are propagated in a direction opposite to the direction energy 

would actually flow. Virtual propagations are often useful for placing virtual sources or pupils. See 

also the definitions for “Real propagation” and “Thicknesses”. 

Wavelength data 

Wavelength data are always measured in micrometers referenced to “air” at the current system 

temperature and pressure. The default system temperature is 20 degrees Celsius, and the default air 

pressure is 1.0 atmospheres. If the system temperature and/or pressure is modified, or under the 

control of multi-configuration operands, care must be taken to adjust the wavelengths to the new 

air temperature and pressure. 

Wavelength data is entered in the Wavelengths section of the System Explorer. 

Wavelength data are always measured in micrometers referenced to “air” at the system temperature 

and pressure.  
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Working F/# 

Working F/# is defined as 

 

where θ is the real marginal ray angle in image space and n is the index of refraction of image 

space. The marginal ray is traced at the specified conjugates. Working F/# ignores surface apertures 

but considers vignetting factors. 

For off axis field points or non-axial systems, working F/# is determined by the average of the 

square of the numerical aperture between the axis ray and four marginal rays, at the top, bottom, 

left, and right side of the vignetted pupil. The average of the square of the numerical aperture of the 

four rays is converted back to equivalent F/#. 

Working F/# is generally much more useful than image space F/# because it is based upon real ray 

data at the actual conjugates of the lens. See also the definition for “Paraxial working F/#”. 

If the marginal rays cannot be traced (due to ray errors) then a smaller pupil is temporarily used to 

estimate the working F/#. In this case, Zemax scales the data to estimate the working F/# at the full 

pupil size, even though rays are not be traceable at the full aperture. 

If the marginal rays are nearly parallel to the chief ray, the resulting F/# may become so large as to 

be inaccurate. Zemax will automatically “cap” the F/# at 10,000 if the calculated F/# becomes larger 

than 10,000. This result simply means the F/# cannot be calculated accurately using rays. Such a 

large F/# means the output beam is nearly collimated, and many assumptions Zemax makes are not 

valid in this case. The two solutions are to bring the nearly collimated beam to a focus using a 

paraxial lens, or to use the exit pupil size and position to estimate the F/#. For more information, see 

the explanation of “Method To Compute F/#” in the Advanced section of the System Explorer. 

For a generalized definition of F/# useful for evaluating image brightness, see the discussion of 

“Effective F/#” in the discussion about the Relative Illumination analysis. 
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